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An excerpt from The U.S. Department of Transportation Federal Aviation 
Administration Flight Standards Service Copyright 1980

 THE EFFECT AND USE OF CONTROLS
 This chapter briefl y discusses the devices with which the pilot
 operates the airplane in the air and on the ground, and how those  
 devices are to be used eff ectively.

 To maneuver an airplane, the pilot must control its movement 
 around its lateral, longitudinal, and vertical axes. This is
 accomplished by the use of the light controls—elevators,

ailerons, and  rudder—which can be defl ected from their neutral
 position into the fl ow of air as the airplane moves forward through 
 the air. During fl ight, the  fl ight controls have a natural “live
 pressure” due to the force of the airfl ow around them.

 With this in mind, the pilot should think not of moving the fl ight 
 controls, but of exerting force on them against this live pressure
 or resistance.

ELEVATORS
 The elevators control the movements of the airplane about its
 lateral  axis. They form the rear part of the horizontal  stabilizer, and 
 are free to be moved up and down by the pilot, and are connected to 
 a control stick or wheel in the cockpit by means of cables or rods. 
 Applying forward pressure on the control causes the elevator 
 surfaces to move downward. The fl ow of air striking the defl ected 
 elevator surfaces exerts an upward force, pushing the airplane’s tail 
 upward and the nose downward. Conversely, exerting back pressure 
 on the control causes the elevator surfaces to move up, exerting a 
 downward force to push the tail downward and the nose upward 

 In eff ect, the elevators are the angle-of-attack control. When back 
 pressure is applied on the control, the tail lowers and the nose rises, 
 thus increasing the wing’s  angle of attack and lift.
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 Some airplanes have a movable horizontal surface called a
 “ stabilator,” which serves the same purpose as the horizontal 

stabilizer and elevators combined. When the cockpit control is 
 moved, the complete stabilator is moved to raise or lower its leading 
 edge, thus changing its  angle of attack and amount of lift. In turn, 
 this changes the wing’s angle of attack and amount of lift.

AILERONS
 The ailerons control the airplane’s movement about its longitudinal 

axis. There are two ailerons, one at the trailing edge of each wing, 
 near the wingtips. They are moveable surfaces hinged to the wing’s 
 rear spar and are linked together by cables or rods so that when one 
 aileron is defl ected down, the opposite aileron moves up. 
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 Contrary to popular belief, the lift on the wings is the force that
 turns the airplane in fl ight—not the  rudder. To obtain the horizontal 
 component of lift required to pull the airplane in the desired
 direction of turn, the wings must be  banked in that direction. When 
 the pilot applies pressure to the left on the control stick or turns
 the control wheel toward the left, the right  aileron surface defl ects 
 downward and the left aileron defl ects upward. The force exerted 
 by the airfl ow on the defl ected surfaces raises the right wing and 
 lowers the left wing. This happens because the downward defl ection 
 of the right aileron changes the wing  camber and increases the angle 
 of attack and life on that wing. Simultaneously, the left aileron moves 
 upward and changes the eff ective camber, resulting in a decreased 

angle of attack, and less lift. Thus, decreased lift on the left wing and 
 increased lift on the right wing causes the airplane to roll and bank
 to the left.

 Since the downward defl ected aileron produces more lift, it also 
 produces more drag, while the opposite aileron has less lift and less 
 drag. This added  drag attempts to pull or veer the airplane’s nose in 
 the direction of the raised wing; that is, it tries to turn the airplane 
 in the direction opposite to that desired. This undesired veering is 
 referred to as adverse  yaw. To demonstrate this in fl ight, an attempt 
 can be made to turn to the right without using the rudder pedals. 
 As right aileron pressure is applied, the airplane rolls into a right 
 bank and tries to turn to the right. But the adverse yaw, or the drag 
 on the downward defl ected left aileron, pulls the airplane’s nose 
 to the left. The airplane banks, but is turns hesitantly and sideslips. 
 This is undesirable and corrective action should be taken by applying 
 right rudder pressure.

 When right rudder pressure is applied simultaneously with right 
 aileron pressure, it keeps the airplane from yawing opposite to the 
 desired direction of turn. In fact, the rudder must be used because 
 the ailerons were used. Therefore, neither of those controls should
 be sued separately when making normal turns.
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RUDDER
 The rudder controls movement of the airplane about its vertical

axis. This is the motion called  yaw. Like the other primary control  
 surfaces, the rudder is a moveable surface hinged to a fi xed
 surface—in this case to the vertical  stabilizer, or fi n. Movement
 of the rudder is controlled by two rudder pedals—left and right. 
 Its action is very much like that of the  elevators, except that is moves 
 in the diff erent plane; the rudder defl ects from side to side instead of 
 up and down. When the rudder is defl ected to one side, it protrudes 
 into the airfl ow, causing a horizontal force to be exerted in the
 opposite direction. This pushes the tail of the airplane in that
 direction and yaws the nose in the desired direction. When rudder
 is used for steering during ground taxiing, the propeller slipstream 
 provides the force to yaw or turn the airplane in the desired
 direction.

 USE OF  FLIGHT CONTROLS
 The following will always be true, regardless of the airplane’s
 attitude in relation to the earth:
 • When back pressure is applied to the elevator  control, the
 airplane’s nose rises in relation to the pilot.  

 • When forward pressure is applied to the elevator  control,
 the airplane’s nose lowers in relation to the pilot.  

 • When right pressure is applied to the  aileron  control, the
 airplane’s right wing lowers in relation to the pilot.  

 • When left pressure is applied to the aileron  control, the
 airplane’s left wing lowers in relation to the pilot.  

 • When pressure is applied to the right rudder  pedal, the
 airplane’s nose moves to the right in relation to the pilot.  
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 • When pressure is applied to the left  rudder  pedal, the
 airplane’s nose moves to the left in relation to the  pilot.

 The preceding explanations should prevent the beginning pilot
 from thinking in terms of “up” or “down” in respect to the earth, 
 which is only a relative state to the pilot. It will also make
 understanding of the functions of the controls much easier,
 particularly when performing steep 
 banked turns and the more 
 advanced maneuvers. Consequently, 
 the pilot must be able to
 properly determine the control 
 application required to place 
 the airplane in any attitude 
 or fl ight condition that
 is desired.

 banked turns and the more 
 advanced maneuvers. Consequently, 
 the pilot must be able to
 properly determine the control 
 application required to place 
 the airplane in any attitude 
 or fl ight condition that
 is desired.
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General Controls

Mouse, for general panel  controls
 You can  drag engine controls, set frequencies, and manipulate any
 other on-screen controls with the mouse. Note: For aircraft with reverse 
 thrust, such as the Boeing 777, you need to drag the  throttle all the way 
 to the bottom of the throttle travel with the mouse and hold the mouse 
 button down for a few seconds at the very bottom of the throttle travel 
 to drop the engines into reverse thrust.

  Joystick, mouse, or  keyboard, for flight control
 The joystick,  rudder pedals and throttle-quadrant operate the fl ight 
 controls of the airplane. If you don’t have any such peripherals hooked 
 up, you can use the mouse and keyboard instead. To use the mouse, 
 click in the center of the windshield and you will be able to fl y the 
 plane with the mouse that way. Click again in the center of the
 windshield to stop fl ying the plane with the mouse. You can use
 the numeric keypad to fl y the plane with the keyboard.

 Normally, you will use the joystick to  pitch and  roll the airplane, the 
 rudder pedals (on the fl oor) to steer the airplane on the ground, and the 
 throttle to control the power output.

 Many people do not have joystick AND rudder pedals AND throttle, so 
 you can get by with the mouse for fl ight control, no rudders, and the 
 mouse or functions keys (F1/F2) for throttle control.

 Keyboard
 Keyboard use is not required. Command key equivalents, if any, are 
 listed in the X-Plane menus. There are also command key equivalents 
 for views in the “View” menu so you do not have to memorize the 
 keys... they are surrounded by brackets like this “[W]”. Just hit those 
 keys without hitting the shift, option/alt or control keys to select
 those views.

GENERAL CONTROLS
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 Tip
 Although reducing the realism somewhat, you may want some
 “damping” if you are new to fl ight sims or are fl ying a light  helicopter. 
 Do this in the “Hardware and Flight Mode” window in the “Settings” 
 menu. You can reduce  joystick sensitivity there, too.

Key List:
 The keys given here are the DEFAULT keys, but you can easily change 
 them by editing the “RESOURCES : KEYS : X-Plane.txt” fi le! Just 
 change the keys in that fi le and save the fi le to use your new keys
 in X-Plane!

 SPACE BAR Fail a system selected in the  failure mode window
 Activate ATC if ATC menu not up
 Accept ATC selection if ATC menu is up
 Send message to other player in multiplayer fl ight
 Close open window if any window is open
 Choose ATC option if an ATC menu is up
 Rotate view angle (free-view)
 Rotate view location (in spot-view)
 Reverse thrust
 Release payload (jettison)
 Adjust directional gyro
 Adjust barometric pressure
 Adjust OBS 1
 Adjust OBS 2
 Pause
  Brakes, 2/3 stopping eff ort, normally used.
 Brakes, maximum stopping eff ort!
 Gear
  Transponder ident
 Progress time in 1/2 hour increments
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 Toggle FADEC on/off  for helos
  Autopilot disconnect
 Autopilot heading
 Autopilot Nav 1
 Autopilot Nav 2
 Autopilot  GPS
 Autopilot alt hld
 Autopilot vertical speed hold
 Autopilot glide slope Nav 1
 Autopilot glide slope Nav 2
 Autopilot airspeed hold

 Com 1 radio frequency
 Nav 1 radio frequency
 Com 2 radio frequency
 Nav 2 radio frequency
  ADF frequency
  Transponder setting
  Flaps up or down one
  Carb heat off  or on
 Speedbrake up or down one (use joystick  throttle on gliders)
  Aileron  Trim
  Rudder Trim
  Elevator trim
 Zoom in/out

 Function keys control the throttle,  prop, and  mixture... with one
 exception: use the BACKSPACE key instead of the F-10 key in
 Windows. In Windows the F-10 key is reserved by Microsoft for
 menu-operations.

GENERAL CONTROLS
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GENERAL CONTROLS

Controlling X-Plane with a joystick

  Roll: The stick controls the airplanes pitch and roll.
 Roll is movement about the longitudinal  axis of the aircraft. To control 
 roll use side to side motion of the stick. Moving the stick left to right 
 will cause the aircraft to roll until the stick is re-centered. The amount 
 of roll is called the angle of  bank. Once the aircraft has banked the ports 
 of lift is no longer vertical, but at an angle equal to the bank angle. If 
 the pilot pulls back on the stick while banked some of the lift goes to 
 the left or the right turning the aircraft in the direction of the bank.

 

ROLL
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Pitch:  Pitch is motion about the aircrafts lateral  axis. Pitch causes the 
 nose of the aircraft to move up or down relative to the horizon. To
 control pitch use forward and back stick pressure.

Yaw: Yaw is the movement of the aircraft right or left
 about the vertical axis.

PITCH

YAW
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Your First Flights

 • Launch X-Plane from the Start menu (Windows) or 
  by double-clicking on the “X-Plane” icon in the 
  game folder (Mac OS.)
 • Wait until you are settled on the runway.
 • Hit the ‘2’ key a few (about 2 ) times to bring in 
  some  fl aps for takeoff .
 • Disengage the  brakes. (Click the orange brake button to toggle it.)
 • Operate the  throttles with the  mouse. (The throttles are the light-gray
  knobs on the lower-right... drag them up all the way to go to full 
  power.)
 • Pull the  joystick back (or hit the numeric keypad 2 key, or click on
  the center of the windshield and pull down with the mouse) lightly
  to rotate and take-off  at about 130 knots.
 • Upon reaching 3,000 feet or so throttle back a bit.
 • Hit the ‘1’ key a few times to retract the fl aps.
 • Fly the plane for a few minutes with the joystick/mouse/keyboard.
 • Select “Quit” from the “File” Menu.

Now you can fly the simulator

 • Double-Click on the “ Plane-Maker” icon, thus launching
  Plane-Maker.
 • Go to the “File” menu and select “Open”.
 • Select the Boeing 777 from the “Heavy Metal” folder.
 • Select a random window from the “Standard” menu and make
  any changes you feel Boeing overlooked.
 • Select “Save As” from the “File” menu.
 • Type in “Modifi ed 777” or similar for your new modifi ed airplane
  after backspacing over the earlier name and press return.
 • Select “Quit” from the “File” Menu.

FIRST FLIGHT
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 Now you know how to make your own airplane designs.

 • Launch X-Plane. 
 • Select “Open Aircraft” from the “File” menu. 
 • Choose the airplane that you just saved in Plane-Maker...
  yes you might need to navigate around a little bit to fi nd it.
 • Fly it. (If you still can!)

 Now you are an aircraft designer and test pilot!

OK you have now proven that you can fly, design aircraft, and test-fly
your aircraft designs.

 You are probably not any GOOD at it, but at least you can do it. A
 minute to learn, a lifetime to master. The rest of this manual will walk 
 you through everything in much more detail.

FIRST FLIGHT

INTRO TO X-PLANE
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Organization will be as follows: First we will outline what the sim can 
do, then walk you through each menu, then walk you through the various 
flight instruments.

Once you are familiar with the menus and instruments, we will walk you 
through a first flight in a conventional plane, then give you descriptions of 
how to fly helicopters, the Space Shuttle, theoretical planes on Mars, and 
other stuff you only find in X-Plane.

First: What X-Plane can do

 X-Plane is the world’s most comprehensive fl ight simulator, and the 
 most  realistic fl ight simulator available for personal computers. It is 
 the only consumer-level fl ight sim on the market that can predict how 
 an airplane will fl y based on the GEOMETRY (shape) of that airplane.

 While every other sim has a visual model of the aircraft for “eye  
 candy” and a diff erent set of rules to govern the fl ight, X-Plane takes 
 the shape of the aircraft as defi ned in Plane-Maker and uses it both to 
 render the airplane visually as well as see how air would interact with 
 that  shape to provide the fl ight model.

 This means that in X-Plane, you can enter the design of the aircraft of 
 your dreams, not knowing whether it can really fl y or not... and then 
 fi nd out by taking it for a test-fl ight in X-Plane

 In all other sims, you have to enter the performance of your design 
 into the sim, so the sim can blindly spit that performance right back 
 out at you. You learn nothing!

 X-Plane is being used by various aircraft manufacturers and designers 
 to evaluate new design ideas on the personal computers before the 
 planes are fl own for real... the processing power that is required
 for this was unthinkable several years ago, but on today’s PC’s is
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 obtainable at a mass-market price-point, making fl ight-performance 
 prediction possible for $50.00 that has typically cost hundreds of
 thousands of dollars for custom-built software.

 So what can you fly on X-Plane?
 Try  props, jets, single- and multi-engine airplanes, as well as gliders, 
 helicopters and  VTOLs such as the V-22 Osprey and AV8-B Harrier. 
 X-Plane comes with subsonic and supersonic fl ight dynamics, and 
 includes 28 aircraft spanning the aviation industry (and history),
 and several hundred more are freely downloadable from the internet.

What X-Plane can do

 X-Plane’s scenery includes scenery for the entire continental U.S. 
 Global scenery is available and sold separately. Visit www.graphsim.
 com to learn more. You can land at any of thousands of airports, as
 well as test your mettle on aircraft carriers, helipads on building tops, 
 frigates that pitch and  roll in the waves, and oil rigs.

 Weather is variable from clear skies and high visibility to
 thunderstorms with controllable wind, wind shear, turbulence,
 and microbursts! Rain, snow and clouds are available for an instrument 
 fl ying challenge, and thermals are available for the gliders! Real 
 weather conditions can be downloaded from the internet, allowing
 you to fl y in the actual weather that currently exists for the airports
 that you are closest to!

 X-Plane also has detailed  failure-modeling, with 35 systems that can
 be failed manually or randomly, when you least expect it! You can fail 
 instruments, engines,  fl ight controls, and landing gear at any moment.

 While X-Plane is the world’s most comprehensive fl ight sim, the CD 
 also comes with  Plane-Maker (to create your own airplanes) World-
 Maker (to create your own scenery), and Weather Briefer (to get a 
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 weather briefi ng before the fl ight if you use real weather conditions 
 downloaded from the net).

 X-Plane is also extremely customizable, allowing you to easily create 
 textures, sounds, and instrument panels for your own airplanes that 
 you design or for the planes that come with the sim.

 X-Plane’s accuracy (in fl ight model), scope (in aircraft and terrain
 coverage), versatility (in aircraft type and weather conditions),
 add-on programs (in aircraft and scenery editors), user-customizability, 
 downloadable aircraft, and downloadable scenery makes it the

ULTIMATE fl ight simulation experience for BOTH major platforms.
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The X-Plane Menus 

OK, let’s quickly go through each menu in X-Plane to see what this baby 
can do. Once we have gone through all the menus, we will take a look at the 
cockpit instrumentation.

 File Menu

  Open Aircraft
  This works just like opening a text fi le in a word-processor, only you 
  are opening an aircraft to go fl ying instead! Fun! Just select your 
  favorite airplane, provided it is available on the disk, and go fl y it! 
  The aircraft fi le must be in the “X-Sytem” folder to be selectable!

  Load/Save Situation or Movie
  Just set up the location, weather, airplane, etc any way you want
  and save the situation. 

  You can load that situation again whenever you want. Situations
  are saved in the “Situations” folder in the “Output” folder. Ditto
  all that for movies, which are saved in the “Movies” folder in the 
  “Output” folder.
  
  Quit
  Exit the simulator.

INTRO TO X-PLANE
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X-Plane remembers the nearest airport, weather, aircraft, etc.
for the next time you restart the simulator.

 The Location Menu

  This starts you off  wherever you want.

  The “Takeoff” and “Final” menus let you select from every airport
  in the general vicinity. (About 100 miles or so). If you want to go 
  farther away than that, then you should select location by Airport, 
  where you can enter any of the 20,000 or so airports in the X-Plane 
  database.

  

  
  The various “Special Approach”, etc. menus are more fun than a
  barrel full of monkeys that have had too much coff ee, and then 
  cooped up too long in the barrel, and then released at a fruit-stand. 
  You can buzz forest fi res in the B-26 water bomber and jettison the 
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  fl ame-retardant load right over the fi res to put them out, try putting 
  an F-4 on an aircraft carrier, try getting an F-4 OFF an aircraft carrier, 
  get towed aloft in your Cirrus glider by a towplane, fl y a helicopter 
  (or the V-22!) to a building top, oil rig, or even a frigate pitching and 
  rolling in the waves. You can fl y the  space shuttle through a complete, 
  realistic re-entry sequence to landing at Edwards...and we haven’t 
  even gotten to what you can do on Mars yet! That’s just here
  on Earth!

  At the bottom of the location menu you can select your planet.. don’t 
  be fooled! The laws of physics are the same on Mars as on Earth (but 
  with thinner air and lower gravity) and these variances are known to 
  X-Plane, so the fl ight on  Mars is just as accurate as the fl ight on Earth! 

The Settings Menu

  Data Output
  This windows is extremely important and you must open it now.
  This is where you can output all manner of fl ight data to the cockpit 
  display, a graphical output, a disk fi le, or even the internet via UDP. 
  Here are some more thorough descriptions:

 • Cockpit Display
  Do this to send data numerically to the windshield, where it is shown 
  in real time. You can look at things like propulsive effi  ciency, engine 
  power output, exact prop RPM or mach number, or any number of 
  other things where you want precise fl ight data. This is commonly 
  used for test-fl ying your own airplane designs.

 • Disk File
  The data requested goes to the fi le “X-Plane.out” in ASCI text format. 
  You can view the data after the fl ight by opening “X-Plane.out” with 
  any word processor. After that, you may choose to import the data 
  into a spreadsheet or graphics program of your choice for thorough 
  analysis or printing or sharing with others.
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 • Graphic Display
  The data requested goes to a graphical display where it can be
  accessed by selecting “Graphic Flight Record” from the “Output” 
  menu. Up to four variable groups may be chosen. This is a good idea 
  for cases where you want to see control defl ections over time from an 
  artifi cial stability system, etc.

 • Internet
  Send data to the internet? Huh? It sounds crazy until you consider 
  the possibilities Say you are making your own virtual cockpit with 
  many computers and monitors... or maybe you are making some
  type of motion platform... or maybe you want data to drive your
  own visual display system... just put an ethernet card in your
  computer if you do not already have one, and select the data you 
  wish to be output here... it will be sent out over the ethernet cable
  by UDP protocol in such a way that there is basically NO FRAME-
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  RATE HIT AT ALL... now you hook up the other end of the ethernet 
  cable to another computer, and you have yourself a little network, 
  with the second computer getting data from X-Plane on the fi rst 
  computer. Now you may burden that second computer with
  hardware or software to drive motion platforms, displays, cockpits, 
  or anything else you can think of, and the frame-rate of X-Plane is 
  not hurt at all since it sent the data to the second machine for
  processing! See X-Plane Internet Output for a full description of
  the fi le formats and how to make it work if you are not a UDP or 
  network guru.

  Internet Connections
  OK, this is where you enter the TCP/IP addresses of all the other 
  computers this computer is talking to for your little “X-Plane
  network” just mentioned above. This is also where you set up
  X-Plane to run with many monitors, other players, instructor
  consoles, etc.

  Rendering Options Item
  This allows you to set the graphics options for the sim. Set to higher
  color depths and texture resolutions if your card can handle it,
  otherwise leave them at the defaults. When in doubt, experiment! 
  With all the video cards and computer and confi gurations in use 
  today, we are not even going to TRY to tell you what settings to use... 
  you need to experiment for yourself!

  If you set the graphical load too high and X-Plane will not restart 
  the next time you try to run the sim because of it, just delete your 
  various X-Plane preferences from the “System: Preferences” folder
  on Macs, or the “System” folder on Windows machines. View fi les
  by name in a list and you will see the various X-Plane preferences
  at the end of the list alphabetically under “X”. You can delete them 
  safely.. X-Plane will just restart to it’s default confi g. when you do.
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  Joystick  Axis Assignment
  This is where you decide what each axis on your joystick does. For
  Macintosh users, this is a standard Input Sprockets interface. For 
  Windows users, be sure to set all unused axis to NONE! See the
  General Controls section of this manual for a more thorough
  description of joystick setup.

  Set Equipment Options
  This is where you decide what each button on your joystick does,
  and choose any special hardware you have, such as radio stacks, etc.

  Test Joystick and Equipment
  This is where you can see how your joystick is responding, as well
  as see if any special hardware selected above is responding. You can 
  also set the joystick damping here. For technically-realistic fl ying, all 
  the damping should be completely turned off , and the joystick
  sensitivity cranked to full. Simulators are harder to fl y than real
  airplanes, though, so you may want to add some artifi cial damping 
  and lower the joystick sensitivity to make the airplane feel more
  realistic.

  Time of Day
  Use this to set the time of day for your fl ights. 
  Dawn (06:00) and Dusk (17:00) are cool-looking. Evening (19:00)
  with an overcast cloud layer is recommended for instrument fl ight 
  (IFR) training. Time will advance in real-time.

  Set Weather (Space, Atmosphere, and Water)
  Note that you have slider control over the meteorological situation at
  various altitudes. These triple-sliders outline the limits you set for the 
  weather at various altitudes. The “rate of change” slider controls how 
  fast the weather is changing. The computer’s internal weather
  generator will keep the weather changing until your limits
  are reached!
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  You can also fl y in actual real-time weather downloaded from the 
  internet!  Check out www.X-Plane.com for the current location of
  the current fi le.

  Conditions for atmosphere, water, and space may also be set. Don’t 
  slide on a wet runway, crash a fl oatplane on a Tsunami, or get
  distracted by a meteor! (Unless you want to, of course.)

  Weights and Fuel
  Use the sliders to set the weights and fuel you want to fl y. Watch
  the maximum take-off  weight! If you fl y over this weight you are 
  asking for trouble!

   Realistic, Instrument and Equipment Reliability
  • Engine  failures will cause immediate lack of power. 
  • Oil pressure failures will cause the engine to slowly lose power
  and then seize
  • Vacuum system failures are realistic, complete with gyro tumble
  as the gyros spin down.
  • Instrument failures will cause the instruments to stay in the
  position they were in when the failure occurred.
  •  Control failures will cause the controls to snap to the center
  position and stay there, simulating cable failure.

  Sound
  Sounds are set here. ATC verbal communications are possible if
  the appropriate speech drivers are installed. The window explains
  in more detail.

  Warnings
  This sets how “strict” the sim is. All boxes should be checked “on” 
  for maximum realism. Check them “off ” if you want to do free-fl ight 
  without worrying about aircraft limitations.
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  Quick-Flight Setup
  Quickly set your aircraft, location, time, and even a little
  weather here. 

The Output Menu

  Graphic Flight Record
  This is where the graphic data selected from the “Data Output” in
  the “Settings” menu can be observed. Point the mouse at whatever 
  part of the curve you are interested in (no need to click) and the
  numerical value of that data appears underneath the labels at the
  left side of the screen. Clicking on the “starting time” controls at the 
  bottom of the screen controls how many seconds since data selection 
  was made you wish to start viewing. 

  Low Enroute, Sectional Chart, Weather Radar Map, Textured Map,
  and 3-D Map
  These plot the local area with your fl ight path plotted in red and 
  black. The weather radar map shows fi ne details if you have
  thunderstorms selected in the “Set Weather” window. You may
  position your aircraft in various maps by setting altitude, speed
  and direction, then clicking in the map. The 3-D Map requires a 
  pretty fast machine to run smoothly, but is a nice site to see if you 
  have the hardware for it.

  Approach Plates for the Local Airports Menu
  Plots the approach plate of the selected airport. This chart is used 
  for setting VOR, ILS, and  ADF frequencies as well as planning ILS  
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  approaches. Notice the elevation of your airport! Fly an
  instrument approach and then open these windows to see how
  your approach looked.

The View Menu

  Many view options are
  available for watching your 
  fl ight. The letters in brackets 
  are  keyboard equivalents. 
  Just hit those keys to get
  the views.

  Enter/Leave Flight Replay 
  Mode off ers a video replay
  of your fl ight. In the 
  glareshield some VCR-like 
  buttons appear, which can
  be pressed to wind up or 
  down, start or stop the 
  replay, or study interesting 
  situations (like crashes). If
  your monitor or videocard
  has video-out you can output 
  the movie to a VCR. You can 
  change the view of the replay 
  with the usual keys from the 
  “View” menu.

The Special Menu

  Output one flight engine cycle
  This saves an extended text fi le to your hard disk with all current 
  simulator data. You can read this fi le with any word processor. This 
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  option is useful for people with an aeronautical engineering
  background or the extremely curious. Use this data to check the 
  simulator output, or observe loads or other data pertaining to the 
  aircraft at the moment that you clicked on this menu item.

  Instructions 
  These are brief but self-explanatory. X-Plane uses help-screens when 
  you leave the mouse-pointer over an unclear subject for a few
  seconds.

  Show Mouse-Click Regions
  This plots annoying little yellow rectangles where you can click with 
  the  mouse... it might be useful for designing custom cockpits, etc. X-
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Plane Primary Instruments 

Go to the “File” menu and select “Open Aircraft”. Select the Cessna 172 
Skyhawk, the most popular plane in the world these days. It is in the
“General Aviation” folder in the “Aircraft” folder.

 With that plane open, read the following:
 Most all aircraft are equipped with the “standard 6” instruments, 
 which give your orientation and velocities in space. They do NOT tell 
 you what piece of real estate you are over (they are NOT navigation 
 instruments) but they tell you what your attitude and speed are, which 
 is what you need to fl y the plane. Navigation is secondary to staying 
 right side up!
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 So what ARE the “standard 6” instruments? Let us tell you:

 “ Standard-6” Flight Instruments

• Airspeed Indicator
  This tells you your speed through the air. It is the upper-left
  speedometer-like instrument. Notice the airspeed arcs (the colored 
  arcs on the edge of the instrument). These arcs go to and from certain 
  critical speeds for the airplane, 

 and here those speeds are:
 • Vso:
  The bottom of the white arc is the stall speed with  fl aps (and gear) 
  down. In other words it is the stall speed in the landing or “dirty” 
  confi guration. 
 • Vs:
  The bottom of the green arc is the stall speed with fl aps (and gear) 
  up. This is the so-called “clean” confi guration.
 • Vfe:
  The top of the white arc is the max. fl ap extension speed. Don’t
  extend your fl aps above this speed.
 • Vno:
  The top of the green arc is the maximum normal operation speed, 
  and the max. speed in rough air.
 • Vne:
  The red line is the maximum allowable speed, or the velocity
  to never exceed. You can lose your wings above this speed.

  Artificial Horizon
  To the right of the airspeed indicator, this instrument displays the 
  plane’s attitude in the air. Note the “level adjust” knob. Use it on
  the ground to adjust the “nose-level” or horizontal reference to
  your liking.
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  Altimeter
  Reading 1,400 feet above sea-level, note it’s barometric pressure
  setting knob. Use it to adjust the altimeter setting. The barometric 
  pressure is preset to 29.92”/1013,2 mbar (hPa), the standard altimeter 
  setting. The altimeter should be adjusted for the local barometric 
  pressure from time to time. Get the barometric pressure by checking 
  ATIS, which can be done by hitting the ENTER key to activate radio 
  communications. Once you get the current barometric pressure
  setting from ATIS, load that into your altimeter to calibrate it
  properly. This is needed for it to read correctly since it works
  be sensing air pressure!

  Turn-Slip Indicator
  Look at the instrument below the airspeed indicator. That is the
  turn-slip indicator. The airplane symbol indicates the rate of turn
  (not bank!) and the ball indicates sideslip. Use your pedals to keep 
  the ball in the center.

  Horizontal Situation Indicator
  Very important navigational instrument with 2 arrow pointers
  controlled by the 2 buttons on either side of the instrument...
  see the next page for further explanation.

  Vertical Velocity Indicator
  The VVI indicates climb and descent rate in steps of 100’s of feet
  per minute.

Standard  Flight Controls

OK so those were the standard flight INSTRUMENTS, which tell 
 you what the plane is doing... now lets go to the standard flight 

CONTROLS, which you will use to control the plane!
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  The General Controls section already clued you in on using the
  joystick and throttle and  rudder pedals, or mouse and keyboard
  for controlling the 4 major fl ight inputs ( pitch and  roll,  yaw, and 
  throttle), but now it is time to take a look at the engine controls.

 Here they are:
   Throttle gray handle (left) up is full
  Prop blue handle (middle), up is full RPM (not available on Cessna 172)
   Mixture red handle (right), up is full rich
   Carb heat little square (right), up is full cold
   Flaps pull down handle in 4 stages, up is retracted
   Trim with arrows on it (right) to trim the plane up/down

  The throttle simply controls the power output of the engine…
  full up is maximum.

  The  prop is like a gearshift in a car.. it controls the pitch of the
  propeller to maintain a constant RPM regardless of the power setting. 
  The Cessna 172 does not have this control because it cannot adjust 
  the pitch of it’s prop, but you can open the Mooney in the General 
  Aviation folder to see and use this control.

  The mixture controls the ratio of fuel to air inside the combustion 
  chambers of the engine... pull it back a bit to save fuel, but if you
  pull it back too far the engine will quit!

  The carburetor heat is needed when landing a carbureted a plane, 
  or ice may form in the engine air intake and strangle the engine! If 
  this happens then activate the carb heat found in the lower right!

  Flaps have a signifi cant eff ect on both  lift and  drag. The fi rst
  bit of fl aps (say 10°, or 1 notch) increases the lift (upward force)
  signifi cantly, yet does not add much drag (braking force). As the
  fl aps are FULLY deployed, however, the lift does not increase that  
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  much more, but the  DRAG goes up a lot. In short, deploy only a 
  LITTLE  fl aps to get a  LIFT boost (like for take-off ) but deploy them 
  FULLY to get maximum lift AND drag (like for landing). Cessnas 
  in particular have very eff ective fl aps for steep approaches and low 
  minimum fl ight speeds. It is not uncommon to have the airspeed 
  indicator pegged on the lower end of the dial while in fl ight in a 
  Cessna with the fl aps down at minimum speed.

  The  trim adjusts the speed at which the airplane will sit without 
  any stick input from the pilot. Use the k/l keys or mouse (HOLD 
  THEM DOWN!) to adjust the trim so that you do not have to hold 
  the stick all day long to hold the plane level.
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Navigation Instruments 

 Open the King-Air B200 in the General Aviation folder if you are not 
 already in that plane.

 Lets take a look at a popular general-purpose navigation instrument, 
 the Horizontal Situation Indicator, or HSI. The horizontal situation 
 indicator is below the artifi cial horizon. The gyrocompass part of this 
 instrument is obviously your heading, but notice the yellow arrow 
 (with line) on this instrument. This is the Omni-Bearing Selector (OBS). 
 It is a course deviation indicator for a VOR or ILS. 

 Put in english, the yellow arrow points to or from the radial that you 
 have selected to fl y from a VOR, or ground-reference station. The little 
 knob on the lower-left of the HSI is the OBS selector knob. Use that 
 knob to adjust the radial to the VOR that you want to fl y. Click on the 
 left or right part of the OBS selector to decrease / increase the OBS.

 Now the next question is, “Ok, so the little yellow knob decide what
 radial I will be on to or from a VOR, but how do I decide which VOR 
 the HSI is taking me to or from?”. To answer that question, you dial
 the frequency of the VOR you want to fl y to or from into one of the
 two NAV radios you have on board. Most planes have 2 nav radios, 
 with an HSI connected to either or both of them. In the Mooney it is
 connected to Nav 2... the lower of the 2 Nav frequencies in the
 radio stack.

 So, in summary: Dial the frequency of a VOR you want to fl y to (the 
 VOR’s are the little hexagons on the maps in the “Output” menu), then 
 twiddle the little yellow knob to select the radial you want to fl y to (or 
 from) the VOR, and then fl y until the line between the two little yellow 
 pointers is centered and you will be on the radial.
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 The small orange arrow on the HSI is the heading-select pointer.
 This is the heading the  autopilot will fl y when the “heading-select”
 (HDG SEL) button on the autopilot in the radio stack is pressed.

 A simplifi ed version of the HSI is the VOR. This just shows the
 defl ection of the aircraft from the radial you have dialed in, without 
 rotating the little needles as you dial in the OBS (or radial) you want
 to fl y. Note the little round knob on the VOR gauge. This is the OBS 
 selector for the VOR, which is hooked up to Nav 1 in the radio stack. 
 Remember that the frequency on the left of the radio stack is used
 for communications, the frequency on the right is used for
 navigation. Click on the left or right part of a OBS selector to
 decrease/increase the OBS.

 The VOR and HSI also have glideslope indicators (horizontal lines)
 for the ILS. While you keep the little pointers centered to be on course 
 on the radial you have selected to a VOR, you keep the horizontal 
 pointers centered to maintain your VERTICAL course on the ILS as
 you follow it down to the airport.

 Remember that VOR’s and HSI’s that we just discussed also work for 
 ILS’s, which are beams that guide you down to the airport with two 
 big diff erences: ILS’s provide vertical guidance as will as horizontal 
 guidance, and ILS’s will always keep you on the SAME radial to have 
 the pointer centered, no matter what you dial into the OBS. This is 
 because the course to the runway has been carefully plotted and 
 aligned with the runway, and the FAA does not want you coming at
 it from just any direction.

Marker Beacon & Audio Selector Panel
 Look at the top of the radio stack. The blue, yellow, and white squares 
 are marker beacon indicators. They will fl ash when you pass over 
 outer, middle, or inner markers during an ILS approach. The buttons
 to the right are the audio selectors. They select what radios go to the 
 speakers, and are only used for the Nav radios and the  ADF in current 
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 versions of X-Plane. To hear and test a VOR, dial the VOR frequency 
 into the NAV2 (bottom) radio, then hit the “NAV2” button in the audio 
 selector panel: you should hear the morse code for the VOR if the VOR 
 is in range. The same can be done for a Nav1 VOR on airplanes that 
 have a VOR for Nav1 radio instead of a  GPS (global positioning   
 system or satellite navigation), and it can also be used for the  ADF.

 DME
 The next instrument down is the distance-measuring equipment. This
 instrument gives the distance, speed, and time to a VOR. Like a real 
 DME, this one takes a little while to give an accurate answer. The two 
 buttons to the right of the display select which Nav radio you want to 
 get the distance to. N1 gets the distance to the VOR selected in the top 
 Nav radio, N2 gets the distance to the VOR selected in the bottom
 Nav radio.

 Nav and Com Radios
 The next two boxes down are the Nav/Com radios. Com frequencies 
 are on the left, Nav frequencies on the right. Frequencies for Nav 1 are 
 on top, frequencies for Nav 2 on the bottom. You’ll be advised by ATC 
 which frequencies to use for communications (press Enter/Return key 
 to activate ATC). Click on the selector knob to change the frequency.

Transponder
 The transponder code your plane should send out is given by ATC 
 and must be set in the transponder by turning the knobs. The code can 
 vary during a fl ight. After setting (“squawking”) the code you can 
 cause your plane to light up on radar by pressing the ID button. The 
 blinking reply light indicates ATC’s radar is tracking you. Set the 
 ransponder to 1200 if you are not talking to ATC. Click on the selector 
 knob to change each digit.
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Autopilot
 The three buttons under the “HDNG bar” are as follows:

 HDG SEL fl y the heading selected by the orange arrow on the
 HSI. Adjust the orange arrow with a knob on the HSI.
 NAV 1 fl y the VOR/ILS selected on Nav 1 (or  GPS module)
 NAV 2 fl y the VOR/ILS selected on Nav 2 (HSI left button)

 The three buttons under the “ALT bar” are as follows:
 ALT HLD hold the altitude selected in the glareshield.
 VVI HLD hold the vertical velocity selected in the glareshield.
 NAV 2 fl y the ILS glideslope selected on Nav 2
 Note: a glideslope for the ILS must be available

 The button under the “AS bar” is as follows:
 AS HLD auto- throttle to maintain the airspeed selected in
 the glareshield.

 GPS - Global Positioning Satellite system
 Open the Glasair-II in the “Homebuilts” folder. (“File: Open Aircraft” 
 in X-Plane, then navigate out a level from the “General Aviation:
 Cessna” folder over to the “Homebuilts: Glasair” folder. Notice that in 
 the Glasair, a GPS replaces the Nav1 radio. The 3 buttons labeled APT, 
 VOR, and NDB select whether you want to fl y to an airport, VOR, or 
 NDB. After making the appropriate selection, dial the identifi ers with 
 the digit and scroll knobs. As usual, click on the knobs to proceed.
 Once you have dialed in your destination you can fl y to it using the 
 GPS. You get a CDI (course-defl ection indicator; the dot between the 
 three | lines), which works just like the horizontal defl ection on a VOR 
 to help you fl y to your destination. In our above example Lyon
 Satolas-France is centered and straight on course.

 DIGIT moves the cursor across the GPS-selection display
 SCROLL when pressed at top or bottom scrolls up or down
 the list or characters and names
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ADF - Automatic Direction Finder
 Get back in the Cessna to use an ADF. The needle of the Automatic 
 Direction Finder will simply point at whatever radio station the ADF
 is tuned to. Notice the three knobs under the ADF indicator. These 
 select the ADF frequency. The ADF  compass rose can be slaved to the 
 compass in Plane-Maker. Click on the  upper part of the knob to
 increase the frequency. Click on the lower part to decrease the
 frequency.
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Flight from San Bernardino to Riverside Municipal

OK, we have given you the intro to X-Plane, we have run you through the 
menus, and we have run you through the instruments. Now it is time for a 
quick flight!

 1. Go to the “Location” menu, “Place Aircraft by Airport” option. Go to  
 San Bernardino, or KSBD, which is the airport ID. That is actually the 
 airport you start at by default, but we are running you through this in 
 case you have moved. In a few seconds you’re on runway 06 of San 
 Bernardino, ready for a short instrument fl ight to KRAL, Riverside 
 Municipal airport - which is about 13 miles west-north-west.

 2. Let’s take a fun plane. Load the Glasair from the “File:Open Aircraft” 
 menu option. It is in the “Homebuilts” folder, as you recall. Austin 
 Meyer, the author of X-Plane, is building one of these in his garage, 
 though it is highly doubtful he will ever fi nish it... it takes too
 much time.

 3. Anyway, press Enter/Return and the up-arrow to fi le your fl ight
 plan. Set
 altitude to 4000 feet and destination to KRAL. Click IFR (top left).
 Close your fl ightplan now by clicking the window close-button,
 top left.

 4. Next use the knobs in the instrument bar below the glareshield t
  set ALT 4000 feet, VVI 1000 feet per minute.

 5. Set the  GPS to the destination airport
 (set “KRAL” - read 215°-13 nm).

 6. Check the airport map of “Riverside Municipal” in the “Plates” 
 menu. Note the heading of the landing runway and its ILS frequency. 
 You will go for runway 9 with ILS frequency 110.9.
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 7. Set the HSI needle to 90 (left yellow knob on the directional gyro)
 and NAV1 to the ILS 110.90.

 8. Select “Settings:Weights and Fuel” to adjust the weight of your
 Glasair. Enter your own weight as the fi xed payload, plus the weight
 of any other people watching over your shoulder while you fl y. Enter
 a half a tank of fuel, or so.

 9. Prefl ight check:  Flaps 1 notch, GPS and Nav radios set, ALT and VVI
autopilot values set, the engine at idle.

 10. Press Enter/Return and select “Pick-up Flightplan”. Check and 
 write down the ATC instructions that follow. Set the  transponder as 
 instructed and load the tower frequency into the COM radio.

 11. Call ATC for take-off  permission and note the instructions.

 12. Release the  brakes (mouse or “b” key), and throttle up to full.
 At about 70 knots gently pull the stick to rotate and take off . At a
 positive climb press the autopilot for VVI SEL and climb to the altitude 
 indicated by Air Traffi  c Control. If climb to 4000 feet is approved, press 
 ALT SEL, and re-enter the VVI selection if needed. 

 13. Follow the instructions from ATC, change radio frequency to
 Departure (if advised) and Riverside’s airport. Don’t misread ATC.
 Ask for a “Say again” when in doubt.

 14. Follow the heading instructions from ATC by hand-fl ying or
 switching the autopilot to HDNG/HDG SEL and turning the orange 
 bug in the HSI with the orange (second left) knob under the HSI to the 
 compass direction ATC has given.

 15. You’ll be vectored to the ILS of Riverside in a wide curve.
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 16. At 13 nm DME from Riverside reduce your airspeed to 120 knots, 
 and set 1 notch  fl aps. Follow the approach instructions from ATC
 carefully now.

 17. You will be advised to “intercept the localizer for runway 09” - 
 press HDNG NAV1 and ALT NAV1 in the  autopilot. The Glasair will 
 turn to the Riverside ILS, fl ying the ILS until you disengage the
 autopilot and land.

 18. When you visually see the runway deselect the autopilot to fl y the
 Glasair gently to the runway. Glasairs like to fl y their approaches at 
 about 80 to 100 knots with partial or full fl aps. Gently raise the nose 
 when close to the ground to ease out of your descent and touch down. 
 Power off , hit the  brakes, and taxi clear of the runway. Hit enter again 
 to tell the tower that you are clear of the active runway and ready to 
 taxi to the ramp for a cold one. (Iced tea if you will be fl ying back to 
 San Bernardino today, beer otherwise)
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Flying Helicopters

 Helo Basics:

Helicopters are so much harder to fl y than airplanes that helicopter 
 pilots almost have contempt for fi xed-wing pilots. Helos have next to 
 no natural stability (if any at all) and require constant attention to avoid 
 busting their blades.

 Ironically, the bigger the helo, the easier it is to fl y since it is larger, 
 heavy, slow, and fi lled with artifi cial stability systems making it easier 
 to fl y! The smaller helos which are light and twitchy are actually the 
 harder ones to fl y!

 Therefore, for your fi st helo fl ight lesson, we will start you off  in the big 
 heavy helo to make it easy for you. Open the UH-60A Blackhawk for 
 your fi rst fl ights. This is a big heavy helo that has a nice solid feel.

 A helicopter is in fact a marginally stable fl ying machine. The
 main rotor produces somewhat more  lift than the weight of the
 helo, allowing the machine to take off  vertically. To  pitch or  roll the 
 helicopter the main rotor blades change pitch as they move around
 the rotor disc. This causes the rotor to put out more thrust on one side 
 than the other, causing the ROTOR DISC to pitch or roll. Once the rotor 
 disc has pitched or rolled, the lift from the disc pulls the helicopter 
 along with it! This change in rotor blade pitch to maneuver is referred 
 to as  cyclic pitch. The cyclic pitch is controlled by the “cyclic” stick 
 which is the main control for the helicopter and is equivalent to the 
 stick or yoke of an airplane. To climb or descend, a helo increases or 
 decreases the pitch of the rotor blades overall, not just when the blades 
 are at one part of their path around the disc. This overall change in 
 pitch is referred to as “collective pitch”. This “collective” is physically 
 set up like a side-mounted parking brake in a car: you pull it up to
 go up, you push it down to go down. The collective is somewhat
 analogous to the  throttle in an airplane. But who controls the actual 

INTRO TO X-PLANE

52



throttle? A computer! The computer in a real  helicopter automatically 
 manipulates the throttle to maintain operational RPM. In other words, 
 the RPM will stay the same for the ENTIRE fl ight (say, 350 rpm) and 
 the computer will vary the throttle to AUTOMATICALLY to hold that 
 350 rpm, no matter what sort of load you put on rotor system by
 pulling the collective. There is a catch though: If you force the rotor to
 a very high collective pitch by pulling up on the collective too much, 
 then the engine might not have enough power to keep a constant
 rotor speed, even at full throttle! RPM will drop and you are in a
 rotor-underspeed situation that must be remedied! The cure is simple: 
 lower the collective stick enough that the  pitch on the blade lowers to 
 the point that the engine can keep the rotor turning at the right speed.
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 Thrust-Master or CH-Products throttle quadrants act like the collective 
 when you are fl ying helos in X-Plane. Throttle full forward is full fl at 
 (DOWN), collective. Ease the  throttle back towards you to INCREASE 
 the collective. The throttle handle is acting like a collective pitch grip
 in the helo, and the computer is actually controlling the engine throttle 
 to maintain the correct RPM, which should stay the same for the
 entire fl ight. 

 Your  rudder pedals, if you have them, act as anti-torque pedals, which 
 simply increase or decrease the  pitch on the tail rotor to  yaw the
  helicopter left or right and counteract the torque of the engine.

 The helo cockpit is smaller than that of airplanes. There is a piece
 of yarn tied to the base of the windshield that serves as a sideslip
 indicator. The  throttle handle serves here as collective pitch grip
 and should be upward to keep the helo on the ground. Gently drag
 it down to take-off  and learn to hover at low altitudes fi rst. Watch your 
 fl ight with the replay option in the View menu to see your crashes from 
 the outside.

 Flying the Helo:

 Ok, let’s go for a flight. The throttle slider should be full FORWARD
 (or full UP on the instrument panel) corresponding to a fully-FLAT
 collective pitch. In this case, there is next to no  lift being generated 
 by the main rotor.

 Now, EASE THE THROTTLE BACK TOWARDS YOU, OR EASE THE
 COLLECTIVE (gray knob) DOWN WITH THE MOUSE. This simulates 
 pulling the collective BACK TOWARDS YOU with the mouse. As the 
 collective increases, the lift from the rotor disc increases. At some point, 
 the helo will rise.

 Now, use the cyclic ( joystick or yoke) to maneuver the helo. You are 
 changing the  cyclic pitch on the blades now, which puts out more lift on 
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 one side of the rotor disc than the other, which tilts the rotor disc, 
 which drags the helo around to follow the disc in response.

 Use the  rudder pedals (or “anti-torque” pedals, in helo terminology)
 to adjust the  pitch of the tail-rotor to  yaw the ship around to the left or 
 right. Once you can hold it on a hover under control, push the nose 
 forwards to “lean” forwards and GO somewhere! Pull the nose back
 to slow or stop for landing.

 You can fi nd Aircraft Carriers, Oil Rigs, 
 Frigates, (tossing in the waves) and 
 building tops to land on, all in the
 location menu. We think that will keep 
 you busy for a while!

Flying to Carriers

 Landing on an
 aircraft carrier 
 seems tricky at 
 fi rst, but gets 
 easier with
 practice. Head on 
 over to a coastal 
 airport like LAX, 
 get in an F-4 
 Phantom, and ask 
 for a carrier
 approach or 
 catshot in the 
 “Location” menu. 
 If the weather is good
 you can fl y your approach visually, otherwise tune an ILS to 108.00 to 
 pick up your ILS signal to the carrier... real carriers use somewhat

 You can fi nd Aircraft Carriers, Oil Rigs, 
 Frigates, (tossing in the waves) and 
 building tops to land on, all in the
 location menu. We think that will keep 

INTRO TO X-PLANE

55



 diff erent frequencies and ILS equipment, but the general result is
 the same. 

 At any rate, get set up on or near the carrier in the “Location” menu,
 “Special Approach” item or navigate to the carrier using the “Textured 
 Map” by looking for a little square with a “C” in the middle. Be sure 
 that “Draw Carriers” is turned on in the “Rendering Options” screen
 in the “Settings” menu!

 If you select Carrier approach you will be aligned with the glideslope. 
 Don’t forget hook and gear down! You might also (quickly!) get full 

fl aps down and reduce your weight somewhat by jettisoning your 
 load... carrier approaches are almost always made at minimal weight.

 OK, the “Hook”, or “arresting gear” is lowered by pushing a little
 button labeled “Arrest Gear” in the glareshield. The landing gear is
 the handle with the three red or green lights by it. There is a button 
 labeled “Jettison” to dump your weapons load to lighten up for the
 approach, and you can hit the ‘2’ key about 5 times to get the fl aps
 all the way down.

 Do all that stuff  fast... you need to get the F-4 confi gured quickly since 
 you are begin started off  pretty close to the carrier and you are coming 
 in at about 200 knots initially! (Though you will want to slow to more l
 like 150 knots).

 At about 1 mile out you will see the Fresnel lens (or “meatball”) on
 the deck just to the left of the wires. It has a row of green lights with a 
 yellow light in the middle. The Airboss will inform you when to “call 
 the ball” (you need not respond in the sim). You now fl y an approach 
 path that keeps the meatball centered. The voice of the Landing Signal 
 Offi  cer warns you of errors in speed, attitude and heading. If the
 Landing Signal Offi  cer is not happy with your approach he will shout 
 “wave off ” at you. Go around and try again. After landing you may  
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 select the “carrier cat shot” again or taxi to the left-front catapult to be 
 automatically hooked up for a shot.

 The visual glideslope indicator with “meatball” indicates the following:
 • If the center light is above the row of green lights, you are high. 
 • If the center light is below the green lights, you are low or
  swimming!
 • If the center light is right in the middle, between the green lights, 
  you’re on glideslope like you should be.

 The trick to the carrier landing is:

 • Keeping the plane aligned laterally with the extended centerline of
 the deck. (Do this with heading, of course)

 • Keeping the airspeed low enough that the nose is aimed a bit up 
 from the horizontal, at a nice positive  angle of attack. (Do this
 with  pitch)

 • Keeping the velocity vector of the  HUD pointed right at the
 touchdown zone on the deck. (Do this with pitch and  throttle).

 • Keeping the meatball centered. (Do this with throttle)

 • Keeping all the these parameters centered until you crash into the
 deck. There is no technique to landing on a carrier other than keeping
 these parameters perfectly centered until you impact the deck and let
 the arresting gear take care of the rest.

 We are assuming, of course, that you actually catch the arresting gear.
 Sometimes you won’t! In that eventuality, you actually need to go to 
 full throttle right BEFORE touchdown so that the engines are spooled 
 up for the “bolter” or go-around in the event you miss the wires! Of 
 course, you do not know in advance if you will miss the wires, so you 
 should go to full power right before every touchdown so you will be 
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 able to “touch and go” off  the edge of the deck and bring it around for 
 another pass. It is a good workout to go round and round with the
 arresting gear up, doing bolter after bolter around the traffi  c pattern!

Trans-Atmospheric Flight Operations

 The  Space Shuttle gets stuff  into orbit with some reliability, but is
 awfully expensive to operate for obvious reasons. They have to
 refurbish the solid rocket boosters every fl ight, they need a new
 external fuel tank every fl ight, the orbiter requires signifi cant
 maintenance every fl ight, and the fuel consumption is, shall we say, 
 “signifi cant”. (The fuel pumps alone use more horsepower than the 
 total power output of the “Queen Mary”... when you use more power 
 than the total output of the queen mary just to pump the fuel out of the 
 tank, you know you are burning fuel).

 The National Aerospace Plane, or “NASP” is an X-Plane (number 30, or 
 “X-30”) conceived to be the next generation of orbital delivery vehicle. 
 It will take off  with jet engines like an airplane, then switch to rocket 
 engines at high altitude where the jet engines quit putting out an thrust. 
 The rocket engines will take the plane into orbit, where payload can be 
 deployed. The plane will then fl y a re-entry into the atmosphere, and 
 fi re up the jet engines again for a normal landing.

 Flying the NASP takes practice, but this will get you started. Open up 
 the NASP in the “X-Planes” folder and fi ll it up with fuel (“Settings:
 Weights and Fuel”). Go to LAX or some other huge runway and blast 
 off  in full afterburner. Throttle back to 100% no burner and climb to 
 30,000 feet or so. Hit the burner again when the engine thrust starts 
 feeling sort of weak. At about 45,000 feet, or as far as you can climb 
 with the engines, shut them down. (Yank the red fuel levers back). Hit 
 the JATO (Jet-Assisted Take-Off ) button to simulate the rocket engines 
 that will punch you into space. The JATO is simply a solid-fuel rocket 
 motor. The real NASP will use liquid fuel, but that is a technicality.
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 During the rocket assisted climb, gradually level the nose so that the 
 artifi cial horizon is horizontal at about the time you reach 300,000 feet. 
 X-Plane’s atmosphere goes up to about 250,000 feet, so you will be “in 
 space” at 300,000 feet. If you climb into space at 45 degrees upside 
 down, you will never get a decent re-entry, so gradually level the nose 
 as to level out at 300,000 feet. Watch the artifi cial horizon carefully. You 
 must level off  in the top of a gentle curve at a reasonable altitude to 
 have a chance of making a survivable re-entry.

 At this moment, your indicated airspeed will be zero, but of course
 this is because there is no air to push against the pitot tube. Your actual 
 speed is extreme, and can be output from the data output window. 
 18,000 mph is orbital velocity. You will have noticed during the climb 
 that the indicated airspeed was going down as you entered thinner air 
 and the airspeed indicator encountered less air pressure, but the true 
 airspeed was always increasing.

 Once in space, keep the space-bird pointed straight ahead until the 
 rocket burns out. Use stick and  rudder to always keep the nose pointed 
 right at the fl ight path velocity vector (the small green moving box) on 
 the  HUD. This keeps the nose pointed in the direction you are going. 
 You will need this during re-entry! Once your rocket burns out
 (4 minutes is up, you can’t climb further and your engine thrust from 
 the “Data Output” window is 0) it is time for the re-entry. Hit the
 “Jettison” button in the glareshield to jettison the satellite you just
 carried into orbit. Ease the plane into the atmosphere at a shallow 
 angle! Don’t go diving straight down at the planet or you will break  
 and burn up like a meteor for sure! The  Space Shuttle skips along in
 the upper atmosphere to gradually bleed off  airspeed, and you must
 do the same. 18,000 miles per hour at sea level would tear any aircraft 
 ever made apart in a micro-second! While you keep the nose up a bit 
 and skip across, gradually descending down into the atmosphere and 
 decelerating, look for an airport on your EFIS display and fl y to it for 
 landing. You can do it!
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Flying the  Space Shuttle

Read this chapter before 
attempting Space Shuttle land-
ings in X-Plane if you want to 
live!

What do you think the first rule 
of flying a glider is?

Think about it.

The first rule of flying a glider is: 
“Never come
up short.”

When you are bringing a 
powered plane in for landing, 
if you think you are not quite 
going to make it to the runway, 
it is no big deal.. just a add a bit 
of power to cover the extra dis-
tance! Need a little more speed 
maybe? Again no problem: Just
add power.

 Gliders play by a diff erent set of rules, though: There is no engine 
 to provide power, so when setting up your landing, you must
 always have enough altitude and speed to be able to coast to the
 airport, because if you guess low by even one foot, you will hit the   
ground short of the runway, crashing. You must NEVER be low on 
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 speed or altitude, because if you EVER are, you have NO WAY of
 getting it back: a crash is assured. (the exception is thermals, or rising  
 currents of air, which can give effi  cient gliders enough boost to get the 
 job done, but thermals will typically provide less than 500 feet per 
 minute of vertical speed... not enough to even keep a lightweight 
 Cessna in the air!) 

 Now with the  Space Shuttle, it is certainly true beyond doubt that it
 has engines. Three liquid-fuel rockets putting out 375,000 pounds of 
 thrust EACH, to be exact. (To put this in perspective, a fully-loaded 
 Boeing 737 tips that scales around 130,000 pounds or so, so EACH 
 ENGINE of the orbiter could punch the Boeing straight up three times 
 the acceleration of gravity indefi nitely.. and that is not even considering 
 the solid rocket boosters attached to the Shuttle’s fuel tank that provide 
 MILLIONS of pounds of thrust!)

 I think this safely establishes that the Space Shuttle has engines.

 The problem is FUEL. The orbiter exhausts everything it’s got getting 
 up INTO orbit, and there is nothing left for the trip down: Thus the 
 ship is a glider all the way from orbit to touch-down on Earth. With
 the fi nal bit of fuel that is left after the mission, the orbiter fi res its 
 smaller de-orbit engines to slow it down to a bit over 15,000 miles per 
 hour (I love saying that... SLOWING DOWN TO A BIT OVER 15,000 
 MILES PER HOUR) and begins it’s descent into the atmosphere.

 Now we have to remember the cardinal rule of gliding: ALWAYS AIM 
 LONG (PAST your landing point, not short), BECAUSE IF YOU EVER 
 AIM SHORT YOU ARE DEAD SINCE YOU CAN NEVER MAKE UP 
 LOST SPEED OR ALTITUDE WITH NO ENGINES. Aim LONG since 
 you can always dissipate the extra speed and altitude with turns or 

speedbrakes if you wind up  being too HIGH, but you are SCREWED
 if you come up SHORT.
 Following this rule, the orbiter intentionally fl ies it’s glide from orbit
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 EXTRA HIGH TO BE ON THE SAFE SIDE.

 But there is one problem: If the orbiter fl ies it’s entire approach too  
 high, won’t it glide right past Edwards? No.

 And here is why: For most of the re-entry, the shuttle fl ies with the
 nose WWWAAYYY up for EXTRA  drag, and making steep turns to 
 intentionally dissipate the extra energy. The nose-up attitude and steep 
 turns are very ineffi  cient, causing the shuttle to slow down and come 
 down to earth in a steeper glide-angle... and if it ever looks like the 
 orbiter might not quite be able to make it to the landing zone, they 
 simply lower the nose to be more effi  cient and level it out in  roll to quit 
 fl ying the steep turns... the orbiter then glides better, and they can 
 stretch the glide to Edwards for sure. The extra speed and altitude is
 the ace up their sleeve, but the drawback is they have to constantly 
 bleed the energy off  through steep turns (up to 70 degrees bank angle!) 
 and draggy nose up (up to 40 degrees!) to keep from overshooting
 the fi eld!!!

 OK, I will now walk you through the re-entry process from the
 beginning, as it is done in the real shuttle, and all of this carries over 
 perfectly to the shuttle landing in X-Plane, which you will fl y after 
 reading this chapter.

 After de-orbit burn, the shuttle heads for the atmosphere at 400,000
 feet, 17,000 miles per hour, and 5,300 miles away from Edwards. (Yes, 
 you are landing in the Mojave desert and you are starting your landing 
 approach West of Hawaii). Not a bad pattern entry, huh? In reality, the 
  autopilot fl ies the entire 30-minute re-entry, and the astronauts do 
 not take over the controls of the shuttle until the fi nal 2 minutes of the 
 glide. The astronauts COULD fl y the entire re-entry by hand, but it is 
 offi  cially discouraged by NASA. Something about the gruesome death 
 of hurtling through the upper atmosphere at Mach-20 on fi re if the pilot 
 messes up, I think. In the history of Shuttle missions (the 100th mission 
 has just come to a close as I write this), the real  space shuttle has been 
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 hand-fl own for the entire re-entry only ONCE, by an ex-marine pilot,
 as I understand it, who was ready for the ultimate risk and challenge. 
 Oh yes, did I mention you will be hand-fl ying the entire mission in
 X-Plane as well?

 I have not gotten around to writing an autopilot for the Space Shuttle in 
 X-Plane yet... I will have to do that some day... maybe after I sort my 
 sock drawer...

 Anyway, you start in X-Plane around 400,000+ feet, in space, coming 
 down to eat air like a bag of bricks at Mach-20. Your control will be 
 limited in space (you are operating off  of small reaction jets on the 
 Orbiter, set up as “Puff ers” in Plane-Maker), but once the shuttle hits 
 atmosphere, there will be some air for the fl ight controls to get a grip 
 on and you will actually start to be able to fl y the thing. You will fi rst 
 hit air at about 400,000 feet, but it will be so thin it will have almost no 
 eff ect at all. Your airspeed indicator will read around ZERO. Kind of 
 odd since you are actually doing over 15,000, huh? Not really. The 
 airspeed indicator works just like the wings of the orbiter: based on 
 HOW MUCH AIR IS HITTING IT! And in space, that ain’t much! It
 will build gradually as you descend. The odd thing is that even though 
 you are actually SLOWING DOWN, the airspeed indicator will RISE as 
 you descend into thicker air that puts more pressure on the airspeed 
 indicator! You LIKE this oddity of the airspeed indicator, though, since 
 the air is also putting more pressure on the WINGS, so the airspeed 
 indicator is really measuring how much force the WINGS can put out 
 for you, which is really what you are interested in!

bottom line: the airspeed indicator indicates your true airspeed times 
 the square root of the air density, so it indicates lower in thin air, but 
 the  wings put out less  lift in thin air as well, so the airspeed indicator 

works very well to tell you how much lift you can get out of the wings.
 (Word to the wise: If the airspeed indicator is putting out MORE than 
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 about 250 knots, your  wings can have plenty of  lift to carry you.. if the 
 airspeed indicator is indicating LESS than about 250 knots, then the 
 wings do not have enough air hitting them to lift you, and you are still 
 more or less coasting in the thin upper atmosphere where the air is too 
 thin to do much for you.)

 So as the airspeed indicator on the  HUD gradually starts to indicate
 a value (as you descend into thicker air), you know it means you
 are starting to ease down into the atmosphere at 15,000 mph like a
 sunburned baby trying to ease into a boiling-hot jacuzzi: VERY
 CAREFULLY AND SLOWLY. Remember, if you were going 15,000 mph 
 in the thick air of sea level, you would break up into a million tiny 
 pieces in a microsecond... the only reason you can survive 15,000 mph 
 up here is the air is so thin it has almost no impact on the ship. (And 
 again, the airspeed indicator tells you how much the air is really
 impacting the Orbiter... 250 is a “comfortable” amount). The trick is
 for you to be going a lot slower than 15,000 mph by the time you get 
 down to the thick air of sea level. And be at Edwards Air Force Base. 
 And that is what the re-entry is for... dissipating speed as you descend 
 so that you are never going too fast for the thickness of the air that you 
 are in... you only descend into the thicker air once you have lost some 
 speed in the thinner air up higher... the whole thing is a smooth process 
 where you never ram the ship into thick heavy air at too high a speed.

 Now as you begin to feel the out tinges of the earth’s atmosphere, you 
 will notice a slight ability to fl y the ship as you get some air over the 
 wings and speed on the HUD.. now look at the picture of the orbiter
 on the right-hand EFIS display... the Atlantis already has this display 
 retrofi tted over it’s old steam gauges (the EFISs from the Atlantis
 are modeled very accurately in X-Plane.. astronauts could use it for 
 familiarization for sure). You see yourself and the path down to
 Edwards. Your goal is to stay on the center path. If you get above it,
 you are too fast or too high... you might overshoot! If you get below it, 
 you are too slow or too low: You might not make it! (Remember ,the 
 line is drawn with a large margin for error, so if you stay on the line, 
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 you have plenty of extra energy... getting BELOW the line a LITTLE 
 will only tap into your speed/altitude reserve... getting BELOW the 
 line a LOT will keep you from making it to Edwards) You must stay 
 right near the center green line. The green line represents the desired 
 SPEED for the early part of the re-entry, the desired TOTAL ENERGY 
 for the middle part of the re-entry, and the ALTITUDE for the fi nal 
 phase of the re-entry. Don’t blame me, that is the way NASA set it  
 up. If you are too FAST OR HIGH (above the center line) then it is time 
 to dissipate some energy: put the thing in a steep bank, pull that nose 
 up and hang on!

 The REAL orbiter will be about 40 degrees nose up, in a 70 degree
 bank to try to lose energy, going 14,000 mph, glowing red hot, hurtling 
 through the upper atmosphere on  autopilot leaving a 10-mile long trail 
 of ionized gas behind it while the astronauts just watch.

 So how was YOUR day?

 Anyway, you will do steep turns to dissipate energy as needed to keep 
 the orbiter from going above the center green line. Look at the little 
 blue pointer on the far left-hand side of that right-hand display. That 
 indicates how high the nose is supposed to be. The green pointer is 
 where the nose is now. Get that nose up. The pointers just to the right  
 indicate the desired and current deceleration... you will not fl y those, 
 though. Look at the little pointer up top on the horizontal scale. That
 is the computer’s estimation of how much  bank angle you probably 
 need to stay on the center green line. Follow the computer’s
 recommendation or your own intuition for how much bank to fl y,
 but keep that nose up for sure to keep you in the upper atmosphere 
 and fl y STEEP BANKS to dissipate the extra speed and altitude. You 
 might be tempted to just push the nose down if you are high. Don’t. 
 You will drop down into the thick air and come to an abrupt stop from 
 the tremendous  drag, and then you will never make it to Edwards.
 You will wind up swimming in the Pacifi c somewhere around Hawaii. 
 Now, as you make your steep turns, you will be pulled gradually off  
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 course. Switch your turn direction from time to time to stay on course... 
 turn left a while, then right, then back to the left again. That is what 
 they do in the real Orbiter... you are slalom-skiing through the upper 
 atmosphere at Mach-20. Not too shabby. Watch Edwards on your center 
 EFIS display. You want to go there. Hit the “@” key to see yourself on 
 a fl yby. Fast enough for you? Hit the “w” key to get back in the cockpit. 
 Caps lock off ! Caps lock off !

 As you approach Edwards, right on your center green line on the
 right-hand display, you will notice there is sort of a circle or something 
 out past Edwards. This is your Heading Alignment Cylinder, or H.A.C. 
 You will fl y PAST Edwards at about 80,000 feet or so, fl y AROUND 
 THE OUTSIDE OF THE H.A.C. like you are running around a dining-
 room table or something, and then after you come around you will be 
 pointed right at Edwards. And if you are on the green line still, your 
 altitude will be just right for landing as well. This is usually where they 
 turn off  the  autopilot and hand-fl y the real Shuttle.

 Now you are doing about 250 or 300 knots, coming down at about 
 15,000 feet per minute or so... about 125 miles per hour of descent rate. 
 Do I really need to tell you what will happen if you hit the ground with 
 that 125 miles per hour descent rate? Do not aim for the runway or you 
 will wind up smeared along it in a thin buttery paste. Aim for the
 fl ashing glideslope lights 2 miles SHORT of the runway that I (and 
 NASA) have thoughtfully provided for you. If they are all red, you are 
 too low. (oops) If they are all white, you are too high (hit your speed-

brakes, key “6” or use the mouse). If the lights are half red and half 
 white, you are right on your glideslope. (about 20 degrees... airliners
 fl y their approach at 125 knots, 3 degrees descent angle.. we use 250 
 knots, 20 degrees descent angle... not too unusual when you consider 
 pattern-entry started West of Hawaii, actually).

 OK so you are at 250 knots, on the green line, lined up with the runway,
 looking at half red, half white glideslope lights with the fl ashing strobes 
 by them. Hold that approach confi guration until the you are pretty 
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 close to the ground (3-degree glideslope to the runway), then level the 
 descent and get your gear down. (“g”-key or mouse) Get the nose up 
 for a fl are as you approach, and touch down smoothly. Now lower the 
 nose. Now hit the  parachute and even the  brakes if you want and let
 it roll out.

 Now do it 100 times in a row without a single hitch and you are as 
 good as NASA.

 austin

 PS: Special thanks to Sandy Padilla for providing most Shuttle
 re-entry information!
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Flying on  Mars

 NASA has very exact data on the atmospheric pressure, density, and
 temperature on Mars.
 NASA has very exact data on the gravity of Mars.
 NASA has rough topographic maps for the entire planet of Mars, and
 very detailed data for some areas.

 The laws of physics, which are programmed into X-Plane, are the 
 exactly the same on Earth as on Mars. X-Plane needs atmospheric
 pressure, density, temperature, gravity, and topographic maps to
 deliver an engineering-accurate fl ight simulation.

 Enter a new level of flight simulation. X-Plane can simulate Mars.

 The following is an e-mail sent by Austin Meyer, author of X-Plane,
 to the X-Plane community, at 4:35 AM, February 24, 2000:

 I DID POSSIBLY THE MOST EXCITING THING I HAVE EVER DONE
 TONIGHT. (OK, technically I fi nished it THIS MORNING). As some of you
 may know, I have been gathering data on Martian atmosphere, gravity,
 surface “texture”, and topography for X-Plane from various NASA sites  
 (http://ltpwww.gsfc.nasa.gov/tharsis/mola.html, for example)

 I do NOT yet have the TOPOGRAPHY for Mars, but I DO have everything
 else, and I have gotten it all entered into X-Plane and designed two planes
 to fl y on Mars as well, and have been experimenting with deign and fl ight
 on Mars for the last 6 hours or so. (Could I be the fi rst human to fl y a real-
 time fl ight simulation of Mars? I have seen many “movies” of “fl ying” over 
 Mars terrain, but NONE have been hooked to an actual realistic FLIGHT
 MODEL... has NASA done a REAL-TIME simulation of Mars fl ight in a
 PILOTED aircraft? Has ANYONE?) Well, I have for the last 6 hours, AND
 IT IS FRIGGIN FASCINATING.
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 First of all, the atmosphere is ONE PERCENT as thick on Mars as it is on
 earth... INDICATED airspeed is proportional to the square root of the air
 density, so the INDICATED airspeed is ONE TENTH the true airspeed.

 The result: If you take off  with 60 knots on the airspeed indicator, your REAL 
 speed is SIX HUNDRED KNOTS! (about Mach 1) Take it from me, Mach-1
 takeoff s are quite a thing to behold, when the plane will barely leave the
 runway at that speed.

 While there is almost no AIR for you, you do have the (sort of ) advantage
 of only about ONE THIRD the GRAVITY, so it is three time easier to get
 airborne!

 Result: A take-off  in a well-designed airplane can occur at a “mere” 400
 knots or so, indicating all of 40 knots on the airspeed indicator!

 Sound easy? IT ISN’T, BECAUSE WHILE YOUR GRAVITY (WEIGHT) IS 
 ONLY ONE-THIRD OF EARTH’S, YOUR INERTIA IS STILL THERE IN
 FULL FORCE! So you are fl ying with only 1/3 the total  lift of what you
 are used to having to stay in the air, which seems fi ne UNTIL IT COMES
 TIME TO TRY TO TURN OR FLARE!!!!! THEN you see that while the lift
 for STAYING airborne is only 1/3 of Earth’s, the INERTIA, and thus the lift 
 needed to CHANGE DIRECTION (this includes the landing fl are!) IS STILL 
 THERE IN FULL FORCE! The problem is, you DON’T HAVE THAT KIND
 OF LIFT, SINCE THE AIR IS SO THIN!

 Bottom line: All airplanes on  Mars are AIRBORNE TITANICS:
 Ripping blissfully along, unaware of their impending doom due to
 their inability to TURN against their tremendous inertia.

 Landings are impossible without arresting gear. If you can work the fl are out 
 right (it IS possible with advance planning) then you will touch down doing 
 about 400 mph. Now how do you stop?
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 • PARACHUTE? NOPE!!!! 400 mph is only 40 mph worth of  drag due to
 the thin air. You will run off  the end of the runway going 100 mph with the 
 chute only “seeing” 10 mph: USELESS for slowing down.

 • BRAKES? NOPE!!! You only have one-third gravity, so only 1/3 of your 
 weight on the wheels. NO TRACTION!

• REVERSE THRUST? NOPE!!!! With only 1% atmosphere, jet or  prop
 engines can put out basically no thrust... just barely enough to keep the
 airplane in fl ight at mach-0.85.. the jet plane needs a JATO to take off !

 So how do you stop? I fi nally went with ARRESTING GEAR. I know of no
 other way to avoid blasting off  the end of the runway at 200 knots with the 
 chute uselessly deployed and brakes uselessly locked.
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 Speaking of which, CRASHES are interesting. No air  drag to slow the
 tumbling planes down, and little gravity to drag them to a stop against
 the ground! Crashes look like “the Agony of Defeat” from the Olympics
 where the guy on the downhill ski-jump bites it near the top of the ramp
 and tumbles on and on and on, powerless to stop an accident that started
 hundreds of yards earlier! (though on mars, at 400 mph, your plane will
 tumble across the plains for MILES!)

 CRUISING ALONG OVER  MARS is SPECTACULAR, with the scary
 red-orange Martian sky, new Martian rocky-red terrain textures, VISIBLY
 thinner air (due to modifi ed lighting in OpenGL, modifi ed fog in OpenGL,
 and visibility of stars).. you really can tell you are halfway between air and 
 space! Returning to Earth, you feel like you are fl ying in soupy water! Yuk!

 So what sort of planes can fl y on Mars? Not anything from Earth, that’s for
 sure. Not enough  lift or thrust. A Cessna or Boeing will just sit there on the 
 ground without even moving. Put them in the air and they drop like beveled 
 bricks with no wings. Both of my Mars-plane concepts are much like the U-2 
 Spyplane (designed to operate at around 100,000 ft, in similar density air) one  
 with a HUGE high-bypass jet engine built AROUND THE FUSELAGE,
 and another with a smaller rocket engine in the tail, like the X-15. The
 rocket plane has a lower-thrust engine, with plenty of fuel, for about 30
 minutes of fl ight or so... the JET plane can fl y for hours!

 My designs are realistic (again, based on the U-2, with reduced weight for
 the lower structural needs (lower gravity) and modern (composite) materials). 
 The rocket-plane is pretty much guaranteed feasible (known technology across 
 the board) but the jet-powered one I am not sure about since Mars has so 
 little OXYGEN in the atmosphere it may be impossible to keep a turbofan 
 engine running. (My Mars jet-plane has twice the average fuel-consumption, 
 though, to simulate injection of liquid oxygen or nitrous oxide). Bottom line,
 I now know it IS possible to build and fl y a piloted plane on Mars and I now 
 know what it would be like. (though I used a 10,000 ft runway with arresting 
 wires... none of those on Mars now I admit).
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About  Plane-Maker:

 X-Plane comes with a handful of airplanes ranging 
 from the Cessna 172 to the Space Shuttle…that 
 should be enough to keep you busy for a while.

 In the event it is not, you can use Plane-Maker to design your
 own airplanes. You will enter the DIMENSIONS of your aircraft in 
 Plane-Maker, and X-Plane will then try to fi gure out how your airplane 
 will fl y.

 This is totally diff erent from every single other fl ight simulator in the 
 entire world, in which you tell the simulator how the airplane will fl y, 
 and it spits the results right back out at you, thereby teaching you
 absolutely nothing.

 Once you have designed your airplane in Plane-Maker, you can save
 it to your hard disk (anywhere in the X-System folder will do) and
 then take it fl ying in X-Plane. You can also upload your planes to the 
 internet, download other people’s planes, etc.

 In this chapter we will walk through the aircraft design-entry process. 
 For engineers, this should be easy. For pilots not as well versed in the
 fundamentals of aircraft design, fear not! We will explain things for all
 audiences as we go.

 (see the “Plane-Maker Instructions.txt” file with the copy of X-Plane
 for the latest info!) 

 Terminology:

 You will have to enter the locations of various parts of the aircraft
 (of course), so the fi rst thing you should do is pick a reference point 
 (such as the top center of the fi rewall, for example, or the back of the 
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 spinner) to take all of you measurements from.
 Plane-Maker will ask for the following dimensions for each part:

longitudinal arm (abbreviated “long arm”), which is the distance the 
 item is behind the reference point (use negative numbers for items 
 forward of the reference point).

vertical arm (abbreviated “vert arm”), which is how far the item is 
 above the reference point (use negative numbers for items below the 
 reference point).

lateral arm (abbreviated “lat arm”), which is how far the item is to 
 either side of the reference point. (All aircraft are assumed to be
 symmetrical, so most lateral arms are positive, indicating simply the 
 distance from the fuselage centerline. In other cases, the lateral arm is 
 positive-right. You will be able to fi gure out which convention to use 
 based on the situation).

 Again, you may use any reference point you wish, just be sure to use 
 the same reference point for all of the items on each aircraft design!

 OK let’s go. We will go through every function of  Plane-Maker now:

1: Launch “Plane-Maker”.
2: Go to the “File” menu and select “Open”,
3: Select an airplane, like the Mooney in the “General Aviation” folder, 

  that you wish to modify. (Don’t worry, none of the changes you make 
  will be saved unless you decide to save in the “File” menu.. and even 
  then you can save under a diff erent fi lename and thereby not mess 
  up your Mooney!)

 As we go through this tour, change any of the design data you want
 to customize the airplane that you just opened. You then can fl y the 
 modifi ed design when you are done.
 You can save all the aircraft design you like on your hard disk, naming
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 them anything you like, and open them up later in X-Plane just like
 word-processor fi les!

Plane-Maker Menus

Here We go...

 OK, with the airplane of your choice opened, we will go through each 
 window in Plane-Maker... you will fi ll data into each of these windows 
 to design your own plane, if you want to. Just leave the mouse still for
 a second over any number to get a description of that number in plain 
 english... with the on-line help explaining each number individually, 
 this manual will speak in general terms only, not duplicating your
 reading by covering each individual number unless it warrants
 special attention.

 Now, go through each item in each menu, looking at the values there 
 and reading the description here, entering values for your dream plane 
 if desired.

.
  Viewpoint
 This window is for
 entering general pilot’s 
 viewpoint info. The
 left-most box contains 
 the airspeed-indicator 
 markings. These speeds 
 are not used to
 determine airplane
 performance in any
 way, but are ONLY
 for airspeed indicator 
 markings! Make test 
 fl ights to determine spe-
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cifi c speeds for your design if needed. Be sure to 
 set Vne high enough, because X-Plane will break the airplane up if you 
 exceed Vne!

 Here is a quick review of the  V-speeds in case you need them:
• Vso stall speed  fl aps down (“dirty” approach confi guration)
• Vs stall speed fl aps up (“clean” confi guration)
• Vfe maximum fl ap extension speed (don’t get them torn off )
• Vno maximum rough-air speed or “normal operation”
• Vne maximum allowable speed or “never exceed”
• Mmo maximum allowable mach number (if required) The pilot’s eye 

  viewpoint is also entered here. This is simply the location of the 
  pilot’s viewpoint while fl ying. Also enter the location of the various 
  landing lights, nav lights, etc. 

 Use the long arm / lat arm / vert arm convention explained 
 in the previous section.

Panel
Enter the instruments you 
want and the locations of those 
instruments on the panel by 
simply pointing
and clicking. The interface 
is self-explanatory…simply 
choose instruments from the 
list and drag them into place... 
very easy! 
DRAG INSTRUMENTS ALL THE 
WAY OFF THE SCREEN TO DE-
LETE THEM.

Panel
Enter the instruments you 
want and the locations of those 
instruments on the panel by 
simply pointing
and clicking. The interface 
is self-explanatory…simply 
choose instruments from the 
list and drag them into place... 
very easy! 
DRAG INSTRUMENTS ALL THE 
WAY OFF THE SCREEN TO DE-
LETE THEM.
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  Force-Feedback
 Force-feedback  joysticks are joysticks with motors in them that actually
 move the stick in your hands. X-Plane does not support force-feedback
 joysticks now, but this may be added later. Parameters that are relevant
 to force-feedback are entered here.

 Engines Specs 1 & 2
 One tricky area is the number of engines. (!) For  prop airplanes, enter 
 the number of propellers here. If you have multiple engines going to 
 one propeller, just enter the number of engines as ONE (per propeller), 
 and enter the power of all the engines added together as their (total) 
 engine power (directed to that propeller).
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 Another tricky area is the “Design Point” (RPM, advance, and
 associated speed). The design point is the speed and RPM that  prop
 is designed for. It is probably close to the climb or cruise speed and 
 their associated RPM’s, but this up to you!

 Prop  Pitch Limits: When you fi ll data in the design-point boxes, Plane-
 Maker will guess at the pitch-limits automatically. You may override  
 Plane-Maker’s guesses, though, by entering data here. As soon as you 
 change the design point, however, Plane-Maker will put in it’s own 
 best guess again! Be sure to enter zero if you have a fi xed- pitch prop.

Wings, Horizontal  Stabilizer, Vertical Stabilizers, and Pylons

 These are all the wings that contribute  lift,  drag, and pitch- moment 
 in X-Plane. (Yes, even engine pylons can produce lift! They are
 therefore treated as airfoils in X-Plane, just like the wings and
 stabilizers are!)
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 Note: For any surface (like  wing numbers 2 and 3, vertical  stabilizer 
 number 2, or whatever) that your design does not have, enter zero for 
 the wing semi-length. This will tell X-Plane that your aircraft is not 
 equipped with that particular part.

 Semi-Length, Root Chord, and Tip Chord: The “semi-length” is
 the length of the wing from the root to the tip, measured along the
 so-called 25% chord.
 This is the length of the wing from its root to its tip, as measured along 
 an imaginary line that is 25% of the way back from the leading edge of 
 the wing to the trailing edge. Note: This is NOT really the span, since 
 the span is shortened on SWEPT wings!

 Also note that the wing root is usually thought of as being inside the 
 fuselage, at the aircraft’s centerline. There are exceptions to this rule, 
 but we usually put the wing root here, since air pressure from the 
 wings carries over the fuselage to a large extent. As far as the air is 
 concerned, the wings really do go all the way to the centerline of
 the fuselage!

 Enter the root chord (“width” of the root) and tip chord (“width” of 
 tip). Remember that the chord is the distance from the leading edge 
 to the trailing edge of the wing.

 The sweep is the sweep of the 25% chord. Aft (backward) sweep is
 positive. Forward sweep is fi ne, just enter it as negative. The Mooney 
 wing has a slight forward wing sweep. Enter the dihedral (angle of 
 each wing above the horizontal plane). Positive (wingtip-up) dihedral 
 is entered as positive. Negative dihedral, or “anhedral” is fi ne as well. 
 Just enter it negative. For variable sweep wings this value is the
 MINIMUM sweep value!

 Wing sweep makes sense above about 70% of the speed of sound or so,
 where there is a large  drag penalty associated with trying to meet the 
 air head-on. Dihedral helps with stability in  roll... if the wings have 
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 some healthy dihedral then the plane will tend to roll wings-level 
 (eventually) if you take your hands off  the stick... the drawback is that 
 if you ever get into a SIDESLIP situation due to losing an engine on one 
 side or something like that, the plane will try hard to  roll into the
 sideslip because of the dihedral eff ect. (Sweeping the  wings actually 
 causes the plane to act somewhat like it has dihedral, even if it really 
 doesn’t!)

 Has  drag-rudders trailing that wing element:
 The Northrop B-2, among other fl ying wings, has things that look just 
 like  ailerons on the wing tips. The diff erence is, they split open rather 
 that going up and down. This produces drag, which acts like a  rudder 
 for the fl ying wing. You can try that with your fl ying wing designs 
 here. (Just remember to enter a horizontal  stabilizer area of zero for 
 your fl ying wing designs!)

 Note to flying-wing designers: You can have the “ailerons” on the 
 trailing edge of the outboard part of the wing defl ect in unison to act as 

elevators. You will use the “defl ect ailerons with elevators” option in 
 the “Special Controls” menu coming up soon. Just select the part of the 
 wing that has elevons as having ailerons on this screen.

 Horizontal stabilizers type:
  (a) Select “stabilizer” if you want the stabilizer fi xed, with an elevator 
   on the back (like on most Cessnas), or
  (b) a “ stabilator”, if you want the whole surface to move with
   joystick defl ection (like on most airliners).

 If you want to fl y a canard airplane, no problem! Just enter a long arm 
 for the horizontal stab that is in front of the wing. X-Plane will see that 
 you have put the stabilizer in front of the wing and automatically
 deduce that you are fl ying a canard. It will then reverse the elevator
 or stabilator defl ections from a conventional plane to give the correct 
 response.
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 X-Plane will automatically cast downwash from the canard onto the 
 part of the aft wing that is behind the canard. If you are fl ying a
 conventional design, X-Plane will cast downwash from the wing onto 
 the  stabilizer or  stabilator. See the fi le “X-Plane.out” after fl ying your 
 design to see what X-Plane is doing with downwash on your design, if 
 you want. Do this by opening “X-Plane.out” with your favorite word 
 processor.

 Fuselage, Nacelles, Fuel Tanks, and Wheel Fairings
 These are the bodies that create mostly just  DRAG in X-Plane (they the
 fuselage can create some small amount of  lift).

 Most of the contents in these windows is self-explanatory, but the
 fuselage  coeffi  cient of drag may require some explanation:
 The fuselage drag coeffi  cient must include the drag due to fuselage/
  wing interference, fuselage/stabilizer interference, and any other drag 
 that is not accounted for by the wings, stabilizers, and landing gear. If 
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 you do not have fi rm data on what the  coeffi  cient of  drag is, you can 
 make a guess along the following guidelines:
 • Use 0.05 for a super-sleek machine (like the Lancair 360).
 • Use 0.10 is a decent guess for a reasonably “clean” airplane.
 • Try 0.15 for a somewhat “dirty” design.

 Remember, this is the coefficient of drag of the fuselage and
 miscellaneous appendages, including interference drag, based on
 the frontal area of the fuselage.

 If you want to get this data more scientifi cally, and you already have a
 coeffi  cient of drag for your entire aircraft which is based on the wing 
 area, just subtract out the drag associated with the  wing, horizontal 

stabilizer, and vertical stabilizer to get the drag of the fuselage.

 This requires an example:
 Assume the coeffi  cient of drag (at zero- lift) of your airplane is 0.015, 
 based on a wing area of 150 square feet, with a fuselage frontal area
 of 10 square feet. Let us further assume that your wings, horizontal 
 stabilizer, and vertical stabilizer have a coeffi  cient of drag of 0.005 at 
 zero lift. (In “Part-Maker” you may verify these numbers).

 Follow this process to find the coefficient of drag of the fuselage,
 including interference drag, based on fuselage frontal area:
 • Find wing area = 150
 • Find horizontal stabilizer area = 30
 • Find vertical stabilizer area = 30
 • Add those to get total  airfoil area (150+30+30) = 210
 • Divide total airfoil area by wing area (210/150) = 1.4
 • Multiply this by the airfoil coeffi  cient of drag (1.4 x 0.005) = 0.007
 • Subtract this from the total coeffi  cient of drag (0.015&shy;0.007) = 0.008
 • Find the ratio of wing area to fuselage area (150/10) = 15.0
 • Multiply this by the coeffi  cient of drag (15 x 0.008) = 0.12
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 The fi nal number is the fuselage  coeffi  cient of  drag (including
 interference drag) based on fuselage frontal area. Now enter this into 
 “Plane-Maker”. Fun, quick, and easy!
 Section Cuts:
 Drag the little squares around with the mouse to defi ne the fuselage
 geometry. Close the window and look at the airplane on the main 
 screen to see the results of your handiwork. X-Plane will determine
 aerodynamic and mass properties of your airplane based on the
 fuselage geometry, so enter this data accurately!

 The frontal area will be used for drag, and the side and top area will
 be used for  lift and sideforce. The weight of the airplane will be
 distributed across the airplane as well to determine it’s angular
  moments of inertia.

 Control Geometry
 Set control surface sizes and defl ections here. For the controls that you 
 don’t use (for example roll spoiler in a plane without roll spoilers) just 
 enter zero.

 The “chord ratio” is the 
 fraction of the distance 
 from the leading edge to 
 the trailing edge that the 
 surface takes up. It is the 
 part of the total wing 
 chord taken up by the 
 control surface. Almost 
 all controls will be in the 
 15% to 25% range, 
 depending on the control 
 response required. If you 
 have no blueprint or 
 picture on hand it 
 requires some testing to fi nd the optimum values.
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Weight & Balance

  Center of gravity location
  Enter the longitudinal and vertical centers of gravity. The
  longitudinal center of gravity may be close to or just behind the
  longitudinal location of the wing that you entered in the “Wing”
  section. The vertical center you can more-or-less guess... it’s in the 
  fuselage of the airplane somewhere. Scoot it up a bit if you are fl ying 
  a plane like the Lake Amphibian which has the engine way up over 
  the fuselage. Scoot it down a bit for airliners which have large
  engines hanging below the plane.

  Enter the weights of the airplane as well. Empty weight is the weight 
  with no fuel, water, or other payload aboard. Maximum weight is the 
  maximum weight you are allowed to fl y at. The fuel load is simply 
  the maximum fuel you can put in the machine, the water load (used 
  for forest-fi re bombers) is the jettisonable load that you carry. There 
  will be a water-dump button next to the anti-ice button in the cockpit 
  if your aircraft carries water. Dumping he water over a forest fi re 
  puts the fi re out.
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  Landing Gear
 Use this to set the landing gear tire contact point (with the ground)
 locations. Remember this data is WITH THE GEAR DEFLECTED
 UNDER THE GROSS WEIGHT OF THE AIRCRAFT
   Nosewheel steering
  This is how many degrees the nose wheel turns with full joystick or
   rudder-pedal defl ection at various speeds. 2.0 degrees might work 
  well for you at high speeds, and much more for lower speeds.
  (Remember that in a real airplane, the nose wheel may end up being 
  turned more than this by diff erential braking... a pilot would only 
  do this at low speed, though! Remember also that while the
  nosewheel steering on an airliner may only be a few degrees from 
  rudder-pedal travel, he has a little “steering wheel” off  to the side 
  that can steer the nosewheel through almost 90 degrees! Bottom line: 
  Enter a large number for low-speed use to simulate the steering  
  tiller in airliners or diff erential braking in a light plane, and enter a 
  smaller number at higher speeds to simulate nosewheel steering to 
  being only hooked up to the rudder pedals).
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 The Expert Design Menu

  Airfoils
  This is where you select the airfoils for the airplane that you made in
  Part-Maker. (Though X-Plane comes with a handful of airfoils so you
  never really have to make any new ones). FIND THE AIRFOILS IN 
  THE “RESOURCES:AIRFOILS” FOLDER.

  Variable-Sweep Wings:
  Enter whether or not the wing has variable sweep (like the F-14 and 
  B-1). In this case the wing sweep will vary from the degrees of sweep 
  already assigned to the wing in the regular “Wing” window to the 
  amount you enter here in the wing sweep box. Control the sweep 
  during fl ight by moving the wing-sweep control in the cockpit.
  Aerodynamic eff ects of both wing sweep and moving of the center
  of  lift fore or aft are simulate by X-Plane.

  Special Controls
  There is a ton of cool stuff  in here... let’s go through the tricky stuff :
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    JATO
   Jet Assisted Take Off  is a takeoff  where a solid-rocket fuel booster 
   is strapped onto a C-130 or the like to boost the airplane into the 
   air in hurry, making extremely short-fi eld takeoff  possible. Just 
   enter the location, thrust direction (0 is straight back, 90 straight 
   down), thrust force, and duration. A properly-mounted JATO will 
   have it’s thrust line go through a point close behind the airplane’s 
   center of gravity.

    Stabilator/Elevator Differential  Roll Deflection
   F-22’s defl ect their stabilators in opposite directions to help roll.
   Question: How will a Piper Arrow  roll if you do the same thing?
   Answer: The stabilators are so short you won’t get much
   response. They can complement the  ailerons, but not replace them. 
   This feature also works on  elevator defl ection if you are fl ying an 
   airplane with  stabilizer rather than a  stabilator.

   Aileron With Elevator
   The “aileron with elevator” coupling may seem strange, but fl ying 
   wings might use the same control surface for both  pitch and roll.
   If the “aileron with elevator” coupling is set to 0.5 x the control 
   geometry value of the aileron (ie. 20°), then pulling full back on 
   the stick will defl ect the ailerons up halfway, causing the fl ying 
    wing to pitch up. (Remember the fl ying wing has a swept wing,
   so raising the ailerons is like raising the elevator on a conventional 
   plane: it pushes the back of the plane down, raising the nose). This 
   poses an interesting idea for conventional airplanes: What if 
   pulling back on the stick pushed the tail down (regular elevator) 
   and the main wings up (with aileron-droop)? This would increase 
   pitch response and help  lift the airplane! This is something you 
   might try on the Cessna 172. Note that a positive numbers pull
   the aileron upward when the elevator goes up, and negative
   numbers will push the aileron down. Test this phenomenon while 
   viewing the airplane from the outside with the “|” key to see the 
   controls move.
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   Arresting-Gear Equipped
   Arresting gear is used for carrier landings. If you shoot a carrier 
   approach remember to lower your arresting gear! Use the little 
   button in the glareshield’s auxiliary instrument bar.

   Aural Warning Equipped
   Aural warning system equipment warns you of being too low, 
   coming down to fast, not lowering your landing gear, etc.

   Automatic Deployment
   Automatic deployment of slats,  brakes, and speed brakes (like 
   airliners have) can be had. You can also select automatic wing 
   sweep with fl ap retraction. This is used by the Beech Starship.
   As the  fl aps retract, the canard sweeps aft to keep the plane in
   balance. This option only works with airplanes that have  variable-
   sweep wings or variable-sweep horizontal  stabilizers.

   Speedbrake Frontal Area
   Enter the frontal area of the speedbrakes when fully deployed 
   here. This doesn’t include speedbrakes, or spoilers, that are 
   mounted on the wing. This option only applies to speedbrakes 
   that are mounted on the fuselage (or maybe other places) that do 
   not aff ect the  lift of the airplane, but only the  drag.
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    VTOL Controls
   Designing a VTOL (Vertical Take-Off  and Landing) aircraft is fun 
   but challenging. Enter “yes” or “no” in the selection box to
   indicate whether you want your aircraft to vector thrust for
   hovering or not.

   
   The tilt-rotor VTOL (Vertical Take-Off  & Landing) aircraft can 
   obtain its fl ight control in the same way a helicopter does: by 
   adjusting what is known as the “ cyclic pitch” of the rotor blades. 
   This is a process whereby the  pitch of the blades varies depending 
   on where the blade is on its trip around the hub. This creates a  lift 
   asymmetry that will pitch or  roll the aircraft. In this window you 
   enter the degrees of pitch that a blade is increased or decreased  
   with full joystick pitch and roll defl ections.

   Another way to obtain control of a VTOL aircraft is to do it the 
   same way the AV-8B Harrier does: “puff ers”. The British like to 
   talk about how they invented the idea, and can’t fi gure out why 
   we Yankees didn’t come up with it sooner. The concept is simple. 
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   Bleed air is taken from the compressor and then sent out through 
   little jets on the tail and  wing tips to steer the airplane around 
   when in hover. “X-Plane” takes the simplest possible approach to 
   simulating this: you just enter the  pitch,  roll, and  yaw  moments 
   associated with full joystick defl ections. (Remember if you don’t 
   know what the maximum moment is, just multiply the force
   exerted by the puff er times the distance from the puff er to the 
   center of gravity of the airplane to get the moment). If you don’t 
   know how much force you need, try some values to see if they 
   give you comfortable authority. That is what the simulator is for!

   Note on propeller-equipped  VTOL aircraft: The control that you 
   are used to seeing as a  throttle acts instead as a collective pitch, 
   with the computer controlling the throttle to maintain some rpm. 
   This is how a  helicopter is typically managed. The collective pitch 
   travel and redline rpm are set in the usual places for prop pitch 
   and rpm in Plane-Maker.

   Artificial Stability
   Unstable airplanes don’t want to point in the same direction they 
   are going. Once they start to point away from the direction they 
   are traveling, they continue to move away from the fl ight path!

   No human is able to fl y such an aircraft for long, so a computer
   is implemented in these aircraft to keep the airplane from ever 
   diverging from the desired heading and attitude. This computer 
   system is called an artifi cial stability system, sometimes referred
   to as “fl y-by-wire” because there are no direct control linkages 
   between the pilot and control surfaces.

   The F-16 and airplanes that are basically just neutrally stable in 
   hover (like the V-22 Osprey), have this control system. This system 
   looks at the control input from the pilot, then determines what the 
   pilot wants the airplane to do and based on this, looks where the 
   airplane is actually going, moving the control surface to obtain
   the desired result.
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   You will probably need an artifi cial stability system in your plane 
   if it is unstable or is a  VTOL design. If it is a VTOL design, you 
   may wish to have the system turn off  at conventional fl ight 
   speeds, and only phase in as you slow down to hover. This is 
   because there is little or no inherent stability in hover. (As fi rst-
   time helicopter pilots learning to hover can attest!) You enter the 
   speed below which the artifi cial stability system is completely 
   engaged (say 60 knots) and the speed above which the artifi cial 
   stability system is completely out of the loop (say 180 knots). The 
   system will automatically phase gradually from one extreme to 
   the other at intermediate speeds. If you are fl ying an unstable 
   aircraft and always want the system to remain on, just enter a 
   phase-in and phase-out speed of 999 knots. The system will
   always be on below 999 knots INDICATED airspeed. Remember 
   that your TRUE airspeed may be much higher than this at high 
   altitudes, while your INDICATED airspeed is still under 99 knots, 
   thanks to the thin air that causes the pressure on the airplane to be 
   lower, and thus the indicated airspeed to be lower as well.

   The fl y-by-wire, or artifi cial stability system, used by “X-Plane”
   is simple yet eff ective: You enter what  pitch and  roll rates you 
   want the artifi cial stability system to shoot for with full joystick 
   defl ections. Look at some examples in the your airplane fi les.
   Output the control defl ections to the graphical output 
   display in X-Plane (Settings:Set Data Output) to see how your 
   controls are responding to fl ight inputs.

   Background Menu and Special Menus
   The items in these menus are mostly self-explanatory One tricky 
   area is the “Output Texture Map Starting Points”, though... Once 
   you have done your airplane, choose this item to have
   Plane-Maker create a “template” bitmap image for you to make 
   your own “paint” or “skin” for the airplane. This will be explained 
   by Plane-Maker when you select that menu item.
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X-Plane comes with scenery files for the United States (including Alaska 
and Hawaii), Canada, Europe, Japan, and Australia. Most of the rest of the 
world can be downloaded free from www.x-plane.com.

 This scenery (terrain elevation and obstacle) data was obtained by
 an adaptive-gridding program that pulled in data from numerous 
 diff erent sources. The advantage is that it allows scenery for the entire 
 planet, the disadvantage is that it does not ‘hand-craft’ each fi le, so 
 some errors concerning lakes and rivers (and buildings that the F.A.A. 
 does not consider to be obstacles to navigation) can occur

 As a result, World-Maker was introduced to allow custom hand-
 crafting of the X-Plane world. You can use World-Maker to improve
 the existing terrain fi les provided on your CD or at www.x-plane.com.

 Three components are responsible for X-Plane’s world: the fi les
 “nav.dat” and “apt.dat” and a multitude of “.env” (environment) fi les 
 plotting the landscape of most parts of the world.

 • The “nav.dat” fi le contains all NAVAIDs for X-Plane.
 • The “apt.dat” fi le contains all the airports.
 • The “.env” (environment) fi les contain all the objects and terrain,
  thus creating the X-Plane virtual world.

 You may notice by looking in your “Resources:Earth nav data” folder 
 and “data” folder on the X-Plane CD that almost all the env fi les are on 
 the CD where they cannot be modifi ed. This will never do at all! You 
 need to get scenery to your “Resources:Earth nav data” folder where 
 you can modify it with World-Maker. Read on...

  (see the World-Maker Instructions.txt file with the copy of X-Plane 
 for the latest info!) 
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 Latitudes, longitudes and .env files
 To edit a scenery fi le to create or edit obstacles, change the height of
 mountains or fi x a lake or river, the correct “.env” (environment) fi le 
 must be in the “Resources:Earth nav data” folder. First look in the 
 “data” folder on your X-Plane CD. Each “.env” fi le is named based
 on the latitude and longitude of the data in it. A fi le named 
 “+010&shy;160”, contains scenery data with its lower left corner
 at a latitude of +010° and longitude &shy;160°.

 Recall: Latitude or “parallels” are imaginary lines running east-west, 
 whereas longitude or “meridians” run north-south. Both divide the 
 Earth into degrees. Each degree is divided into 60 minutes and the 
 minutes are divided into 60 seconds. The location of Washington D.C.
 is given by the crossing of latitude and longitude: “lat” 039°00”00’ 
 North and “lon” 077°00”00’ West. Latitudes to the North of the
 equator are positive values. Longitudes East of the 0° meridian
 (over Greenwich, UK) are given in positive values. 

 Each “.env” fi le is marked by its name which is the lat and lon of the
 lower left (south-west) corner of the covered area. So, if you want to 
 edit the +025&shy;120 area you should put the corresponding env
 folder (“+020-120”, with all of it’s “.env” fi les) in the “Resources:Earth 
 nav data” folder on your hard drive. 

 Each “.env” fi le covers one square degree of latitude and longitude. 
 Each FOLDER covers an area that is 10 degrees latitude by 10 degrees 
 longitude, so a folder can contain up to 100 .env fi les. (No env fi les are 
 required for empty ocean). For X-Plane to fi nd “.env” fi les, the “.env” 
 fi les must be in a correctly-named folder, which you see in the “data” 
 folder on your X-Plane CD... we recommend that you simply copy 
 whole folders-full of “.env” fi les from the CD to the “Resources:Earth 
 nav data” folder for editing... that will save you from having to create 
 and properly name folders. The “.env” fi les in the “Resources:Earth nav 
 data” folder will OVERRIDE the fi les on the CD, so you can edit your 
 own scenery for fl ight in X-Plane.
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 When you open World-Maker you will see at the top left the latitude 
 and longitude of the present “.env” fi le. Scroll around to fi nd the
 area you want to edit. If nothing is present but a dark blue grid,
 then the fi les for the area in question are simply not present in
 your “Resources: Earth nav data” folder, or they are in folders that
 are not properly named.

 Remember, once you copy the “.env” fi les from the CD to the hard 
 drive, Windows will think they are read-only since they came from
 a CD... you will have to change them to NOT read-only in Windows
 by right-clicking on each fi le you want to edit and then selecting the
 fi le properties. Macintoshes can fi gure these details out for themselves.

World-Maker Menus

 The menus in World-Maker are self-explanatory

 File Menu
 You can save Airports, NAVAIDs, or the scenery area you are working 
 on. To actually go to a new scenery area (latitude and longitude) to 
 work on, click on the little arrows in the scenery-editing screen.

  Edit Menu
 Choose what to edit here... Airports, NAVAIDs, or scenery. Also choose 
 to edit Earth or  Mars here! 

 Special Menu
 Pan and zoom and stuff  here... KEYBOARD EQUIVALENTS are listed 
 in brackets for rapid access.

 The “Auto-Flatten Water” option will automatically make the
 water “flat” right up to the coastlines if you have let if get “wavy”
 during editing.

 The “Massive Texture Assign Mode” will apply a texture over a large
 area so you can customize textures for large areas quickly.
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World-Maker Terrain 

 Editing Terrain in World-Maker

 World-Maker has four editing modes: Terrain, Obstacle, Airport, and 
 NAVAID. Select the modes in the “Edit” menu. Use Terrain editing 
 mode to adjust coastlines, elevations, rivers, etc.

 Now suppose you want to adjust the scenery of “.env” fi le “+034-119”.
 Simply press the “lat” and “lon” buttons to get to the right environment 
 fi le after copying that region from the CD to the “Resources:Earth nav 
 data” folder. Lat and lon can have either positive or negative values, so 
 you can reach any region. 

NOTE: Check our website at www.X-Plane.com for regular updates of 
 “.env” fi les and important links to various related issues.

NOTE: The “.env” fi les on the X-Plane CD can only be changed
 when copied to the “Resources:Earth nav data” folder in the
 “X-System” folder on your hard drive. In Windows, you also need
 to set these fi les to NOT READ-ONLY, as they will initially be read-
 only since they came from a CD. X-Plane will look for fi les in the
 “Resources:Earth nav data” folder, and if it fi nds them, use them to 
 over-ride the fi les on the CD.

 The displayed “.env” fi le shows the geographical properties of the 
 map, like hills and lakes in various green or blue shades, yellow
 parallel lines showing runways and various obstacles.

 The geographical properties are modifi able with the “Terrain” option
 in the “Edit” menu. The obstacles (buildings, towers etc.) are
 modifi able with the “Obstacles” option in the “Edit” menu. Both
 information on geographical properties and obstacles are saved in
 the relevant “.env” fi le, while airports and NAVAIDs are saved in the 
 “apt.dat” and “nav.dat” fi les.
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 To modify the geographical properties you can move nodes and change 
 their altitudes or toggle water on and off  by clicking in a quadrilateral 
 fi eld with the mouse. A quadrilateral is a tiny building block within the 
 “.env” fi le that you can see when zooming in on the map. You can also 
 see the map with it’s textures by pressing the Spacebar. Zoom in and 
 out with the +/- keys. Move around with the arrow keys.

 Textures in World-Maker

 X-Plane uses default, generic textures for water, grass, mountain,
 snow, city, and the borders between them. X-Plane automatically
 applies the borders between these textures. All of these default textures 
 are found in the “bitmaps” folder inside your “X-System” folder.
 They are simply 256x256 pixel bitmaps in 24-bit color. 

 In many cases, though, you may want to customize these textures to 
 ones that are more appropriate for any given area. Perhaps you want 
 city, desert, or harbor textures. These can easily be created and added.
 If required you can assign up to 500 diff erent custom textures for each 
 “.env” fi le. To do this, simply create a custom texture (for example
 desert) in PaintShop, PhotoShop, or any other program you like. Once 
 you have created the custom texture that you want to see in the sim, 
 save it as a 24-bit bitmap in the “resources:custom terrain textures” 
 folder. Now launch World-Maker and drop it into terrain editing mode 
 with the “Edit” menu and add the custom textures that you just created  
 by using the toolbar on the left side of the screen.

 When creating custom objects and textures, remember that fi ne lines 
 will cause “jitter” and resulting eye-fatigue! The same applies for
 high-contrast textures, or too many colors. Many simulators manifest 
 such line-jitter and interference by having textures with too high a
 contrast. A smart combination of minimally varying greens and greys 
 (steps of max. 3-5%) will do for a landscape, provided the pattern does 
 not repeat itself. Houses can be simulated by rectangular dark grayish 
 shapes with a black 2 pixel wide border (shadow) at one side. Seamless 

INTRO TO WORLD-MAKER

102



 welding of any BMPs is achieved by carefully copying one 5 pixel wide 
 border to all 3 remaining sides and turning it either vertically or   
 horizontally. Without this you would see the border of the texture.
 Minimize disturbances of the border pattern while working under
 very high magnifi cation.

World-Maker Objects

 Generic Obstacles in X-Plane
 The FAA lists over 30,000 obstructions to air navigation (obstacles)
 and X-Plane has them all, but most of these are represented in X-Plane 
 simply as generic-looking buildings. These obstacles that come with 
 X-Plane include buildings, radio towers, powerlines, cooling towers, 
 and smokestacks. You can easily modify their height and heading, or 
 add new obstacles. Simply get World-Maker into “Obstacle” mode in 
 the “Edit” menu and select your choice from the left-hand side of the 
 screen. You may delete, move, add, or edit the various objects. Press 
 ‘M’ (see the “Special” menu) to cycle through these options. While the 
 default obstacles are functional from an aviation point of view, they are 
 not very exciting to look at since they are simply generic towers, 
 smokestacks, and a few generic building types. This being the case,
 you may want to customize certain buildings so that they really look 
 just like their real-world counterparts. Examples of buildings that you 
 may want to look just like their real-world counterparts may include 
 the World Trade Centers, the Sears Tower, the Statue of Liberty, or your 
 house. This is easy to do using CUSTOM OBJECTS in X-Plane
  Here’s how:

 Custom Obstacles in X-Plane
 Custom Objects in X-Plane are 3-dimensional structures that are
 defi ned by x,z,y-points and have textures on them in 24-bit
 BMP-format. Read “World-Maker Instructions.txt” in your “X-System” 
 folder to see a description of the current format, and how to add your 
 own custom obstacles. The basic idea, though, is that you create a text 
 fi le in the word processor of your choice that contains the geometry of 
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 the custom object, and lists what textures you want to be used on
 that object.

 Note: The surfaces of the custom objects must be designated clockwise 
 as seen from the outside: topleft - topright - bottomright - bottomleft.

 Note: When you are done creating the objects in your favorite
 word processor, be sure to save them, in the “Resources:Custom
 Objects” folder. 

 SAVE THEM AS ASCII TEXT FILES!

 Note: When you save the custom object textures, be sure to save
 them  in the “Resources:custom object textures” folder. Save them as 
 24-bit bitmaps!

 After you have created and saved your custom objects, get World-
 Maker into “Obstacle” mode from the “Edit” menu, and then choose 
 “add custom” and click on the desired location to place your custom 
 obstacle. A small cross will appear. Click in the “change name” box to 
 open the custom object fi le that you created and saved (with a word 
 processor) in the “custom objects” folder.

 Note: Don’t create new env. fi les! Instead edit existing ones on the
 CD! The current elevation maps provide a good starting point for
 your work! 

 You can make the Golden Gate Bridge, the Sears Tower, the Statue of 
 Liberty, the Mirage and GM of Las Vegas, and any other buildings you 
 like for X-Plane. here’s how:

 • Look in your RESOURCES NAV DATA folder.

 • Now look in your CUSTOM OBJECTS folder.
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 • Open the fi le “KSBD Example.obj” in the “SoCal” folder with any 
  word processor... this is a custom building. (IBM users can open with 
  WordPad...you may have to mess with the carriage return to make 
  the carriage returns come out right).

 Anyway, here is the fi le format that you can use to make your own 
 custom objects, including statues, bridges, custom buildings, your 
 house, or anything else.. the sky is the limit. Follow along in the “KSBD 
 Example.obj” fi le to see it in practice:

A

 The fi le must start with a capital ‘A’ or ‘I’ (created on Apple or IBM)
 FOLLOWED IMMEDIATELY BY A CARRIAGE RETURN WITH NOT 
 OTHER COMMENTS.

2

 Then enter the fi le version number... “2” in this case.

 SoCal:KSBD_example

 This is the texture that this object uses. This texture must be used for 
 every bit of the object, but you may use a diff erent part of the texture 
 for each polygon on the object. Simply make a 24-bit BITMAP of
 anything you like and make sure it’s dimensions are a power of 2 and 
 save that texture in your ‘objects’ folder... that texture will then be 
 available for your buildings... there is basically no limit to the number 
 of textures and objects you create. Make your textures in any graphics 
 program that can save bitmaps.

 4 0.5 1.0 0.0 0.5 // concrete base

 The number “4” means that you are about to give a polygon
 (4 corners).
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 You may use “3” for a triangle, “2” for a line, or “1” for a point. (light)

 THERE MUST BE A COMMENT AFTER THE POLYGON
 INDICATOR! THE COMMENT MAY BE ANYTHING YOU LIKE, 
 BUT A COMMENT IS REQUIRED!

 The 0.5 1.0 0.0 0.5 indicate the “s” and “t” parameter of the textures 
 that this polygon will use. In this case, this polygon uses the texture 
 from the 50% to the 100% point on the texture horizontally left to right, 
 and the 0% to the 50% of the texture bottom to top.

 10 10 -10
 15 0 -15
 15 0 15
 10 10 10

 These are the points that defi ne the polygon, X, Y, Z for each corner.
 X is positive meters EAST.
 Y is positive meters UP.
 Z is positive meters SOUTH.
 Defi ne points clockwise starting from the upper-right corner for your
 4-sided polygon.

 Make up to about 30 polygons or so, and then we get to LINES
 (good for antennas):

 2 5 5 5 // antenna on roof
 -10 50 -10
 -10 70 -10

 The “2” means we have a line... Lines do not have textures... instead
 they have colors... the 5 5 5 are the red green and blue values of the 
 lines ON A SCALE FROM 0 TO 10, WHERE 0 IS TOTALLY DARK, 10 
 IS FULL INTENSITY.
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 1 10 10 10 // light on antenna
 -9 55 -9

 Here is a light... the “1” means we have a point (light) and the 10 10 10
 mean it gets a full red, green, and blue... it is a white light.

Note: If you set your light color to 99 99 99 you will get a PULSING
 RED light.

Note: If you set your light color to 98 98 98 you will get a WHITE
 STROBE light.

 99 // ALL OBJECTS MUST END WITH A 99 TO DENOTE THE END
 OF THE FILE!

 You have to put a 99 at the end.

 OK, that is how you make buildings.

 To put them into X-Plane’s world, go into world maker and add them
 as custom obstacles.

 Here is how:
 • Launch World-Maker.
 • Go to an area where you like to fl y.
 • Select OBSTACLE mode from the EDIT menu.
 • Select ADD CUSTOM from the list on the right hand side of the 
  screen and simply click on the map to place the custom object.
 • Backspace over the ‘?’ in the CHANGE NAME fi eld and type
  in the name of the custom object you want to place there... say 
  “BUILDING1” (not BUILDING1.OBJ... there is no need to type in
  the “.OBJ”) to place the building that we just looked at.
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 Now go into X-Plane, go to the airport that you just placed the building 
 near, and look at it.

 OK, you got it... it is ludicrously easy... NOW GO MAKE STUFF!

 World-Maker Airports

 Airports in World-Maker
 To create or edit airports with World-Maker, go to “Edit:Airports” in
 World-Maker. Each airport in X-Plane CLASSIC may have up to 3
 runways. X-Plane 5 off ers unlimited runways, though, and a variety
 of runway surfaces like asphalt, concrete, gravel, dirt, and grass are 
 available. Runways have approach-light options, such as glideslope 
 indications, approach lights leading up to the runway, and the runway 
 lights themselves. You can use the user-friendly interface to design 
 entire airport runway and taxiway layouts with only a few clicks of
 the mouse!

 Airports in a Word-Processor
 The user-friendly interface in World-Maker is there so you do not
 have to edit any fi les by hand, but if you do want to go in and edit the 
 airport fi le manually for some reason, you may certainly open the
 “apt.dat” fi le with a word processor.

 To edit airports with a word processor, you need to understand the 
 file format of the airport.dat file.
 Here is a make-believe sample entry and it’s meaning:

 1 3127 0 1 CZML 108 Mile Airport
 10 51.7352982 -121.3335037 14x 161.50 4877 100.0200
 300.0400 75 1231231
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 Now here it is explained:

1 -------type: airport

 3127 -------elevation of airport

 0 1 -------does not have control tower, but does have standard
 hangars off  to the side

 CZML 108 Mile Airport -------airport ID and name

 10 51.7352982 -121.3335037 -------entry type 10 means runway, then
 latitude and longitude

 14x 161.50 4877 -------runway number, heading (true), length

 100.0200 -------displaced threshold 100 feet this end, 200 feet at the
 other end

 300.0400 -------blastpad overun 300 feet this end, 400 feet at the
 other end

 75 -------runway width

 1231231 -------runway lighting code, with source-code to generate
 it here:

 xint code = 0;
 if(typ==t_asph_pave )code+= 1000000;
 if(typ==t_conc_pave )code+= 2000000;
 if(typ==t_surf_gras )code+= 3000000;
 if(typ==t_surf_dirt )code+= 4000000;
 if(typ==t_surf_grav )code+= 5000000;
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 if(typ==t_surf_asphH)code+= 6000000;
 if(typ==t_surf_concH)code+= 7000000;
 if(typ==t_surf_grasH)code+= 8000000;
 if(typ==t_surf_dirtH)code+= 9000000;
 if(typ==t_asph_turn )code+=10000000;
 if(typ==t_conc_turn )code+=11000000;
 if(typ==t_surf_lake )code+=12000000;
 xint end;
 for(end=0;end<=1;end++)
 {
 xint mfac=(end==0)?1000:1; // end=0 means front of runway,
 end=1 means back of runway
 if(gls[end]==lgt_gls_none )code+=100*mfac;
 if(gls[end]==lgt_gls_vasi )code+=200*mfac;
 if(gls[end]==lgt_gls_papi )code+=300*mfac;
 if(gls[end]==lgt_gls_papi2)code+=400*mfac;
 if(rwy[end]==lgt_rwy_none )code+= 10*mfac;
 if(rwy[end]==lgt_rwy_mirl )code+= 20*mfac;
 if(rwy[end]==lgt_rwy_reil )code+= 30*mfac;
 if(rwy[end]==lgt_rwy_rcls )code+= 40*mfac;
 if(rwy[end]==lgt_rwy_tdzl )code+= 50*mfac;
 if(rwy[end]==lgt_rwy_taxi )code+= 60*mfac;
 if(app[end]==lgt_app_none )code+= 1*mfac;
 if(app[end]==lgt_app_sals1)code+= 2*mfac;
 if(app[end]==lgt_app_sals2)code+= 3*mfac;
 if(app[end]==lgt_app_alsf1)code+= 4*mfac;
 if(app[end]==lgt_app_alsf2)code+= 5*mfac;
 if(app[end]==lgt_app_odals)code+= 6*mfac;
 }
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World-Maker NAVAIDs

 Ancient Roman sailors realized: “Navigare necesse est”. It is necessary 
 to stay on course. They erected lighthouses along the Mediterranean 
 Sea, something we can hardly think of when fl ying above clouds
 nowadays. X-Plane uses the standard aeronautical navaids, like
 non-directional beacons (NDB’s), very high frequency omni-range 
 beacons (VOR’s), instrument landing systems (ILS’s).

 X-Plane comes with over 40,000 NAVAIDs, but if you want to add a 
 few more you can do it in World-Maker in NAVAID editing mode in 
 the “edit” menu. You can use World-Maker to edit and add these
 navaids, or simply open the “nav.dat” fi le with a word processor and 
 edit it manually.
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X-Plane uses aircraft designed with Plane-Maker. These aircraft use  airfoils
designed with Airfoil-Maker!

 In other words, you can use Airfoil-Maker to enter the airfoil
 characteristics of any airfoil, and then use those airfoils on your aircraft 
 in Plane-Maker and X-Plane.

 Remember, an AIRFOIL is NOT a wing! A WING has wingspan, size, 
 is made of metal or some other material, and is usually attached to an 
 airplane!

 An AIRFOIL is simply a mathematical CROSS SECTION used to
 defi ne the wing! Any airplane from a small Cessna to a giant Boeing 
 could in theory use the same AIRFOIL, the Boeing would just use that 
 mathematical cross-section on a much larger wing!

 In Airfoil-Maker, you defi ne the AIRFOIL, which is simply a
 cross-section of a wing, and this airfoil may be used without restriction 
 on any of your airplanes that you design in Plane-Maker.

 If you decide to make custom airfoils for your airplane, make a folder 
 called “AIRFOILS” in the same folder as the your ACF fi le, and save 
 the foils you make in Part-Maker in there. This is needed for X-Plane
 to fi nd them. 

 Now, X-Plane comes with a bunch of airfoils, including at least one for 
 every reasonable use... Therefore it is probable that, for recreational 
 purposes, these will be the only airfoils you will ever need! In other 
 words, there are enough airfoils included with X-Plane that you will 
 probably never have to design your own if you are just fl ying and 
 designing for fun.

 Airfoil-Maker is available to you, however, if want to input your own 
 airfoils for your own aircraft designs because your airplane uses airfoils 
 that were not included with the simulator.
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NOTE:  AIRFOILS ARE STORED IN THE “AIRFOILS” FOLDER 
 WITHIN THE “RESOURCES” FOLDER... GET YOUR AIRFOILS 
 FROM THERE TO LOOK AT EXISTING AIRFOILS.

Airfoil-Maker Menus

The menus of Airfoil-Maker are very simple:

 The File Menu
 The fi le menu works just like the fi le menu of any word processor or
 spreadsheet you have used. You create, load, and save your fi les just 
 like you do with a word processor. The only diff erence is that you are 
 opening and saving fi les that represent airfoils rather than word
 processing documents.

 New
 Use this to generate a new airfoil

 Open
 Use this to open an existing airfoil for viewing or modifi cation.

 Save
 Use this to save an airfoil that you have created or modifi ed.

 Save As
 Use this to save an airfoil that you have created or modifi ed, but under
 a diff erent name.

 Quit/Exit
 Exit Airfoil-Maker.
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Designing  Airfoils in Part-Maker

Every airfoil ever designed has it’s own characteristics, which are its
coefficients of:

  lift, (how much the airfoil wants to lift up)
  drag, (how much the airfoil wants to pull back), and
  moment, (how much the airfoil wants to  pitch up).

 What you see on the Screen
 You’ll see a big black box dominating the screen with green, red,
 and yellow lines on it. 

 The left edge of the chart corresponds to an  angle of attack of &shy;
 20 degrees, and the right edge corresponds to an angle of attack
 of +20 degrees. 

 The center of the chart represents an angle of attack of zero degrees.
 (Remember the angle of attack is the angle of the wing to the air. It
 is the angle at which the wing hits (or “attacks”) the air). 

 The green line is the  coeffi  cient of lift. The red line is the coeffi  cient of 
 drag. The yellow line is the  coeffi  cient of moment. We’ll look at the 
 behavior of each of these lines.

 You will see a number labeled “Reynolds number” on the upper left.
 The “Reynolds number” is simply the air density times the speed of
 the airplane times the chord of the wing divided by the viscosity of
 air (Wow!). Experiments have shown that the coeffi  cients of lift, drag  
 and moment of wings vary somewhat with Reynolds number. For 
 recreational purposes, you can probably neglect any change in
 performance with Reynolds number, so you can just ignore this setting 
 altogether. The number entered in the Reynolds number box may have 
 some impact however on the simulation. For highest realism you can 
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 generate 2 diff erent airfoil fi les for the same airfoil, each fi le at a
 diff erent Reynolds number, and assign them both to your wing!
 X-Plane will fi gure out the Reynolds number on each piece of the plane 
 at least 10 times per second and interpolate between the two airfoil fi les 
 to give the most realistic coeffi  cients for that fl ight Reynolds number.

Pilots should realize: very good accuracy can be obtained without 
 messing with the Reynolds number at all, and without generating two 
 airfoil fi les for each airfoil. You can ignore the above paragraph and the 
 “Reynolds number” slot in the airfoil generation screen without
 sacrifi cing a good simulation.

  What the coefficients are:

  Coefficient of  lift
  Look at the green line. It is the coeffi  cient of lift. Notice that at zero 
  degrees  angle of attack (center of screen) the coeffi  cient of lift is fairly 
  low. (It is close to the thin white line, which represents zero). As the 
  angle of attack increases, the coeffi  cient of lift increases right along 
  with it, until you get to around 16 degrees angle of attack, at which 
  point the coeffi  cient of lift falls abruptly...that is the stall! If you go to 
  negative angles of attack, you see that the coeffi  cient of lift actually 
  gets negative. If you go to a large enough negative angle of attack, 
  the airfoil stalls then, too. It is possible to stall upside down! A good 
  wing will have a decent coeffi  cient of lift (maybe 0.4) at angles of
  attack close to zero, and a nice high coeffi  cient of lift (maybe 1.6) at 
  the maximum angle of attack. A safe  airfoil will also have a stall that 
  is not too abrupt. In other words, the coeffi  cient of lift will fall off  
  gradually at the stall, rather than sharply.

  Coefficient of  drag
  Look at the red line. It is the coeffi  cient of drag. Notice that the
  coeffi  cient of drag is lowest close to zero degrees angle of attack.
  The drag gets higher and higher as the wing goes to larger and larger 
  angles of attack. That is not surprising, is it? The higher the angle you 
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  off set the wing from the airfl ow,  the greater the  drag!  It doesn’t
  matter much whether you are going to positive or negative angles of 
  attack (aiming the wing up or down)... moving the  wing away from 
  it’s most streamlined position increases it’s drag. A good  airfoil will 
  obviously have the lowest drag possible. (Notice that this drag 
  coeffi  cient does NOT include the drag due to the production of  lift. 
  X-Plane will fi gure this drag out automatically). 

   Coefficient of  moment
  Look at the yellow line. It is the coeffi  cient of moment. The coeffi  cient 
  of moment is the tendency of the wing to  pitch up about its  axis, or 
  rotate upwards about the spar. Most wings actually want to pitch 
  down, so the coeffi  cient of moment is usually negative. The moment 
  varies a bit with  angle of attack, often in ways that are a little bit 
  surprising. Typically the moment will be negative for all normally-
  encountered angles of attack, getting especially large in the negative 
  direction as the angle of attack is increased, until the stall, at which 
  point the moment heads back to zero. A desirable characteristic of an 
  airfoil is usually to have a low coeffi  cient of moment. 

 General Info

  Coefficient display box
 One thing that you have probably noticed is that the axis are not 
 labeled, and don’t have numerical values to tell you exactly what the 
 coeffi  cients are. Look at the little box in the upper left-hand corner of 
 the airfoil generation screen. The top number (white) is “alpha” or the 
 angle of attack of the wing. The next numbers are the coeffi  cients of lift, 
 drag, and moment at that angle of attack. Wiggle the mouse back and 
 forth all the way across the monitor, and notice that the angle of attack 
 display changes, and the coeffi  cients with it. The coeffi  cient display box 
 is giving the angle of attack and coeffi  cients of the airfoil at the angle of 
 attack that the mouse is currently pointing at. Just point the mouse at 
 the part of the curve you are interested in, and look at the 
 exact coeffi  cients in the coeffi  cient display box! Easy!
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 One question you might be asking yourself is:

 How do I find what the coefficients are for the  airfoils on
 my airplane? 

 First, you need to fi nd what airfoil your aircraft uses, probably from
 the manufacturer. Then you need to see if that airfoil is included with 
 our program. If you are fl ying a Cessna 182, for example, that aircraft 
 uses the NACA 2412 airfoil, which is included, so you do NOT need to 
 generate your own airfoil for that wing. If you do not know what foil to 
 use, then just leave them as the defaults of Plane-Maker.

 Airfoil selection is a fun and interesting process, because you
 will be looking for the best possible combination  lift,  drag, and

moment characteristics for your particular airplane. If you will be 
 experimenting with your own airplane designs, and are new to the 
 matters discussed in this manual, we highly recommend:

 R/C Model Airplane Design
 A.G. Lennon
 Motorbooks International Publishers and Wholesalers, Inc.

 to get you started. The book is intended for radio control designs, but
 is very straightforward, easy to understand, and all of the principles 
 apply to full-scale aircraft.

 Once you understand the basics of airfoil theory and nomenclature,
 we recommend:

 Theory of Wing Sections
 Abbot and Von Doenhoff
 McGraw-Hill, New York (1949)
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 ...an oldie but goodie! This books has the  lift, drag, and  moment plots
 of many  airfoils in it, so you can choose your favorite airfoil for your 
 design and then enter it into the computer using the technique that is 
 about to be explained.

 In the following discussion, thin symmetrical, thick highly  cambered, 
 and “normal general aviation” airfoils will be discussed. These are 
 three types of airfoils that are good for discussion purposes because 
 they are so diff erent.

 Thin symmetrical airfoils are thin and have the same shape on both
 the top and bottom surfaces. They do not produce very much lift
 or  drag. They typically are used for vertical  stabilizers and often
 horizontal stabilizers as well because they are not called upon to
 produce a lot of lift, and are not expected to produce much drag, either.

 Use thick, highly-cambered airfoils in the foreplanes of canards, or 
 other applications where you want a LARGE amount of lift from a 
 SMALL wing area. These foils are known for providing a large amount 
 of drag as the penalty for providing a large amount of lift.

 So-called “normal general aviation airfoils”, like the NACA 2412, are
 compromises between the two, and are good candidates for the wing
 of a general aviation aircraft.

 Supercritical,  laminar-fl ow, and other possible groupings of airfoils
 exist, but for the purposes of our discussion we will concentrate on the 
 thin symmetrical, thick and highly cambered, and “normal general 
 aviation” airfoils just outlined.

 Airfoil generation buttons
 Now let’s actually generate an airfoil. The fi rst button to click on is the
 coeffi  cient of lift intercept button, the green one labeled “intercept” in 
 the upper left hand corner. To increase this number, just click right 
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 above the numbers that you want to increase, and below the ones that 
 you want to decrease. For example, if the  lift intercept on the screen is 
 0.25, and you want to change it to 0.33 to model your  airfoil, just click 
 right above the “2” in “0.25” and twice below the “5” in “0.25”. You 
 change all of your data that way for the entire design and simulation 
 system. Easy! Now what exactly is a  coeffi  cient of lift intercept,
 anyway? Read on to fi nd out!

 Coefficient of lift intercept, “INTERCPT”
 This is the coeffi  cient of lift at an  angle of attack of 0 degrees. For a
 symmetrical airfoil, this will always be zero, since the air is doing
 exactly the same thing on the top and bottom of the  wing for a
 symmetrical airfoil at zero degrees angle of attack. Symmetrical airfoils 
 are sometimes used for horizontal  stabilizers, and are almost always 
 used for vertical stabilizers. Sleek, skinny wings with low  camber 
 might have a lift intercept of 0.1. Fat, highly cambered foils have a 
 value around 0.6. A typical airfoil like the NACA-2412 (commonly
 used in general aviation) has a value of about 0.2.

Coefficient of lift slope, “SLOPE”
 This is the increase in coeffi  cient of lift per degree increase in angle of 
 attack. A thin airfoil has a value of about 0.1. A really fat airfoil has a 
 value of about 0.08. Fatter airfoils have slightly lower lift slopes. (You 
 will fi nd, however, that lift slopes are almost always very close to 0.1).

Coefficient of lift curvature near the stall, “POWER”
 As the angle of attack gets close to stall, the lift slope is no longer linear, 
 but gradually “levels off ” as it approaches the maximum, or stalling, 
 coeffi  cient of lift. Just play with the power button until you fi nd a 
 power curve that connects the linear and stalling regions smoothly. 
 Chances are a power of around 1.5  will work pretty well. Just play 
 with it until the lift comes up smoothly, then gradually levels off  to
 the stall, since that is what happens with a real airfoil.
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  Coefficient of  lift maximum, “MAXIMUM”
 This is the maximum coeffi  cient of lift, or the coeffi  cient of lift right 
 before the stall. A very thin, symmetrical  airfoil has a value of around 
 1.0. A thick, highly  cambered airfoil has a value of around 1.8. A typical 
 general aviation foil might have a value of around 1.6.

  Coefficient of lift immediate drop at stall, “DROP”
 This is the drop that immediately follows the stall. For thin airfoils, 
 which tend to stall sharply, this value might be 0.2. For many airfoils, 
 however, there is no immediate drop, but instead a more gradual one 
 as the  angle of attack is further increased. In most cases, this number 
 will be zero or very close to zero.

 Coefficient of lift curvature after stall “POWER”
 Diff erent airfoils have diff erent lift slopes after the stall. For skinny, 
 sharply-stalling airfoils the power should be fairly low, perhaps
 around 1.4. For fat airfoils (which usually have more gentle stalling 
 characteristics) this number may be closer to 2.0. Just play with the 
 power button until the data looks like the data you are trying to model 
 from the airfoil chart in whatever book you are getting your airfoil
 data from.

  Coefficient of lift drop from stall to 20 degrees “DROP”
 This is the decrease in coeffi  cient of lift from the stall to an angle of 20 
 degrees. This number might be in the 0.4 range for a thicker airfoil, 0.6 
 for a thinner one. 

 The NACA-2412 has a value of about 0.4 . (The coeffi  cient of lift goes 
 from around 1.6 to 1.2 as the angle of attack goes from around 16 to 20 
 degrees).

  Coefficient of  drag minimum “DMIN”
 This is the minimum coeffi  cient of drag of the airfoil. (Again, not
 including induced drag, which is determined automatically by the 
 simulator “X-Plane”). This minimum coeffi  cient of drag also should
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 not include the “low- drag bucket” of a  laminar fl ow wing. A thick or 
 highly  cambered  airfoil has a value of about 0.01, a typical older 
 general-aviation airfoil such as the NACA-2412 has a value of about 
 0.006, and a really thin, symmetrical airfoil has about a 0.005 value. 
 Laminar fl ow airfoils can approach values of 0.004, but that number 
 should not be entered here, because it will be addressed in the laminar 
 drag bucket buttons soon to come...

Coefficient of  lift at which minimum  drag occurs “MIN D CL”
 Enter the coeffi  cient of lift at which the minimum drag occurs. This 
 value is probably very close to the coeffi  cient of lift at zero degrees 

angle of attack, which is the “lift intercept”. The very fi rst number
 you entered! If anything, the minimum coeffi  cient of drag occurs at a 
 coeffi  cient of lift a little lower than the lift intercept coeffi  cient of lift. 
 This is because an airfoil usually has the least drag at an angle of attack 
 of about zero degrees or just a hair lower.

Coefficient of drag at angle of attack of 10 degrees “D ALPH=10”
 For a thin, symmetrical airfoil, this value might be around 0.015. 
 NACA-2412 comes in with a surprisingly good 0.012. A really highly-
 cambered airfoil might be around 0.025, though.

Coefficient of drag curvature “POWER”
 The power curve is simply the curvature of the drag curve as it changes 
 with angle of attack. You will have to fi ddle with the curvature until the 
 curve looks like the experimental data, but theoretically this number 
 will be around 2.

 Laminar drag bucket location “CL LOCTN”
 Some airfoils, called “natural laminar fl ow” or “NLF” airfoils, have 
 perfectly smooth airfl ow across a large part of the wing, a fl ow pattern 
 called “laminar fl ow” (Where did you think this company got the name 
 “Laminar Research”?) This super-smooth, low-drag fl ow can only
 happen at fairly small angles of attack, though, so there is a “low-drag 
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 bucket”, or area in a small  angle of attack range, that has lower-than-
 normal  drag. The  drag bucket location is usually thought of in terms
 of the  coeffi  cient of  lift. In other words, the center of the drag bucket 
 occurs at some coeffi  cient of lift of the  airfoil. This might happen at a 
 coeffi  cient of lift of around 0.6.
  Laminar drag bucket width “WIDTH”
 This refers to how “wide” the bucket is, or what range of coeffi  cient of
 lift the drag bucket covers. 0.4 is a decent guess.

 Laminar drag bucket depth “DEPTH”
 This is the all-important variable: how much do you reduce your drag 
 by going to laminar fl ow? Answer: 0.002 if you’re lucky. (But that is 
 actually quite a bit. That might turn a cd of 0.006 to 0.004. Quite a large 
 percentage diff erence.).

 Laminar drag bucket curvature “POWER”
 The power curve is the simply the curvature of this low drag bucket. 
 You will have to fi ddle with the curvature until the curve looks like the 
 experimental data, but chances are this number will be around 3 to 5.

  Coefficient of  moment low-alpha change point “ALPHA 1”
 The coeffi  cient of moment is usually linear across the non-stalled angle 
 of attack range. In other words, if the airfoil is not stalled, the moment 
 curve is usually a straight line. After the stall, however, the moment 
 coeffi  cient tends to change direction. For the NACA-2412, the moment 
 coeffi  cient has it’s low angle of attack moment-change at &shy;10 
 degrees, a point corresponding to roughly +4 degrees before the stall.

 Coefficient of moment high-alpha change point “ALPHA 2”
 The NACA-2412 airfoil has it’s high angle of attack moment-change 
 right at the positive stalling angle of 16 degrees.

 Coefficient of moment at &shy;20 degrees “CM 1”
 For the NACA 2412, this number is about 0.075. Notice that this is a 
 positive number. This means that if the airfoil is at a clear negative 
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angle of attack, it will stall and try to  pitch back up to an angle of attack 

 closer to zero. This is a nice eff ect, because the airfoil tends to try and 
 recover from the stall automatically.

Coefficient of  moment at low-alpha change point “CM 2”
 For the NACA 2412, this number is about -0.05, which is a light pitch-
 down. A  wing with a higher  camber will have a value of around -0.10, 
 perhaps even &shy;0.13. A symmetrical  airfoil will have no pitch
 tendency at all here, so 0.0  should be entered for that type of airfoil.

 Coefficient of moment at high-alpha change point “CM 3”
 For the NACA 2412, this number is about &shy;0.025, which is a very
 light pitch-down. A wing with a higher camber will have a value of 
 around &shy;0.10, perhaps even &shy;0.13. A symmetrical airfoil will 
 have no pitch tendency at all here, so 0.0 should be entered for that type 
 of airfoil.

 Coefficient of moment at 20 degrees “CM 4”
 This is the coeffi  cient of moment well into the stall. For the NACA 2412, 
 it is about -0.10. This is a moderate pitch-down, which is desirable 
 because this pitch-down will help recover from the stall.

Finishing Up
 Change all of the parameters we just discussed around a bit, and select
 “Save As” from the “File” menu. Now type in an airfoil name and hit 
 return. Congratulations! You have just generated your own airfoil! 
 Drop it in the “Resources:Airfoils” folder in your X-System folder (to be 
 usable by ALL planes) or a folder that you make called “Airfoils” in the 
 same folder as your airplane designs to be used only by that airplane.
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Briefer 

 Weather-Briefer (or “Briefer” for short) is a simple program that will 
 give you a weather briefi ng before your fl ight. It will do this using the 
 syntax that a real Flight Service Station Specialist would use to give 
 you a briefi ng before your fl ight in an actual plane.

 Just run the program before you fl ight, select your departure and
 destination airports from the large scrolling menus, select your
 airplane and cruising altitude, and hit the “OK What can you tell me?” 
 button. The program will scratch its head for a few moments devising 
 your briefi ng (as a real Flight Service Station Specialist would!) and 
 then give you your weather briefi ng in the appropriate language.

 Now here is where it gets interesting: If you have downloaded Real-
 Weather (actual current weather conditions!) from the internet, then 
 you will get an accurate briefi ng for the fl ight you have planned, based 
 on the actual weather that really exists! In theory, the briefi ng you get 
 from Weather-Breifer will be exactly the same as the briefi ng you 
 would get from a real fl ight service station if you picked up the phone 
 and called them for real! We used to advocate actually calling a real 
 fl ight service station weather-briefer before your fl ights in X-Plane with 
 Real-Weather downloaded from the net, but then the briefer got mad at 
 us since they were busy enough with the REAL pilots... so now we 
 ask you not to do that!

 Want to see where you can get Real-Weather to fl y in, and get a briefi ng 
 with in Briefer? See www.X-Plane.com, Real-Weather section... you can 
 download Real-Weather there!

 If you do not have Real-Weather downloaded from the net, then Briefer 
 will give you a rather boring prediction: It will simply tell you to expect 
 the weather that is currently stored in X-Plane’s preferences! A boring 
 prediction for sure,  but an accurate one... until you change the weather 
 in X-Plane!
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Hacking X-Plane

 First the easy stuff: Changing the keys on the keyboard that you 
 press to do stuff in the sim:

 Open the following fi le: resources/keys/x-plane.txt

 This fi le has all the keys for X-Plane. You can simply type in whatever 
 key you want for each function right in that fi le to change the keys to 
 suit your preference! X-Plane scans that fi le for key commands each 
 time it loads!

 • Customize Your Textures For Any Airplane
  
  To make your own textures for ANY airplane, simply go into Plane-
  Maker, open the airplane you want to make textures for, and select 
  “OUTPUT TEXTURE STARTING POINTS’ from the “SPECIAL” 
  menu. This will create a bitmap that you can then open with any 
  graphics program, such as Photoshop or PaintShop Pro. The bitmap 
  is an outline of the parts of the airplane! Now you can edit that
  image with a graphics program to make the textures (or “paint 
  schemes”) for your airplane! Make sure to save your handywork 
  with the right fi lenames, as described below!

  See the C-119 in the Vintage folder for an example, and the “paint 
  reference. bmp” in the Instructions folder for a map of the
  paint bitmap.

  If the aircraft name is “aaa”, then the custom paint schemes are:

  aaa_paint.bmp <-paint scheme
  aaa_paint_LIT.bmp <-paint scheme at night

132

HACKING X-PLANE



 • Customize Your Instrument Panel For Any Airplane

  • To make your own instrument panel, simply edit the panel ’til 
   your heart’s content in PLANE-MAKER, setting the instruments 
   where you like, etc.
  • Then go into X-Plane with the airplane that you want to
   customize, and take a screenshot (use a graphics program, or hit
   shift-Apple-3 on a Mac).
  • Then open up the screenshot with a graphics program and CROP 
   it down to 1024x750 pixels (cutting out the menu bar), and edit the 
   bitmap (removing the needles and stuff ) until it is like you want 
   it... save it in 24 or 32 bit color.

  • Now save it as follows:

   aaa_panel.bmp <-custom panel, 1024 x 750
   aaa_panel_LIT.bmp <-custom panel, lit up for night use
    1024 x 750
   aaa_panel_RF.bmp <-custom panel, looking to right front,
   1024 x 750
   aaa_panel_R.bmp <-custom panel, looking to right , 1024 x 750
   aaa_panel_RB.bmp <-custom panel, looking to right back ,
   1024 x 750
   aaa_panel_B.bmp <-custom panel, looking to back , 1024 x 750
   aaa_panel_LF.bmp <-custom panel, looking to left front ,
   1024 x 750
   aaa_panel_L.bmp <-custom panel, looking to left , 1024 x 750
   aaa_panel_LB.bmp <-custom panel, looking to left back ,
   1024 x 750
   aaa_test_nearest <-needles and gages,
   copy from the panel_test_nearest in the resources/bitmaps folder
   aaa_test_nearest_LIT<-needles and gages,
   copy from the panel_test_nearest_LIT in the resources
   /bitmaps folder
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   aaa_test_linear <-needles and gages,
   copy from the panel_test_linear in the resources/bitmaps folder
   aaa_test_linear_LIT <-needles and gages,
   copy from the panel_test_linear_LIT in the resources
   /bitmaps folder
   aaa_blend_linear <-needles and gages,
   copy from the panel_blend_linear in the resources/bitmaps folder

 • Customize Your Sounds For Any Airplane

  Notice that there is a “sounds” folder in the X-System folder. The 
  sounds are simply wave fi les, and are the sounds used by X-Plane. 
  Modify them in any way you like, or create new ones, and save them 
  with a fi lename that is simply the airplane name followed by a word 
  that indicates what the sound is to be used for... Be sure to save them 
  in the sounds folder inside the airplane folder.

  For example:

  sounds folder/aaa engn1.wav (the engine sound)
  sounds folder/aaa engn2.wav (the engine sound)
  sounds folder/aaa wind.wav (the wind-noise sound)
  sounds folder/aaa gear.wav (the landing gear activation sound)
  sounds folder/aaa land.wav (the soft touch-down sound)
  sounds folder/aaaboom.wav (the hard touch-down sound)
  any other sound listed in the SOUNDS folder (you can do this with
  any other sound in the SOUNDS folder that comes with X-Plane)

  See the C-119 for an example.
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 • Customize Your Scenery Texture

  To put your custom scenery textures in place, simply create
  your ideal textures in a graphics program such as Photoshop or 
  PaintShop. Save the textures as BITMAPS. Then simply drop your 
  textures into the following folder:

  EARTH NAV DATA:CUSTOM TERRAIN TEXTURES

  Now go into World-Maker and get into Terrain editing mode in the 
  Edit menu... select the “Apply texture below” button and load the 
  textures into World-Maker by clicking on the texture-name boxes. 
  Now just click on the terrain polygons to put your custom textures
  in place. Easy!

 • Populate The X-Plane World with Objects

  To make your own objects for the X-Plane world (such as the Sears
  Tower, Golden Gate Bridge, Statue of Liberty, or your house) go into
  the following folder:

  ADDITIONAL NAV DATA:CUSTOM OBJECTS

  building1.OBJ (an example building located just South of San
  Bernardino fi eld)

  CUSTOM OBJECT TEXTURES
  build1.BMP (a texture used in this building)
  concrete1.BMP (a texture used in this building)
  roof1.BMP (a texture used in this building)

  You will see a sample building and some sample textures for that 
  building...you can create your own objects and textures, too. Follow 
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  those examples (using the fi le “World-Maker Instructions.txt” in 
  your X-System folder) to create your own objects... you can easily 
  create as many objects as you like, using as many textures as you 
  like.. there is virtually no limit on the World-Building you can do.

 • Share Your Work!

 Share your work with others! Upload your custom airplane textures,
 instrument panel bitmaps, airplane wave sounds, or scenery textures to
 ftp.X-Plane.com! Or put them on your own web page, or your friend’s 
 web page, or send them to us for inclusion in later versions of X-Plane 
 if you think they are better than ours!

Special For Cockpit Designers and HardCore Hackers:

 New power in the data output screen allows UDP data to go OUT...but 
 now X-Plane can also receive data IN so you can let your cockpits or 
 controller or whatever you want drive X-Plane! See the UDP Data I/O 
 section of the instructions for more info.
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